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Preface

This guide describes how to use the Thermo Xcalibur™ Quan Browser window to review and 
rework the results of a quantitative analysis.

To provide us with comments about this document, please click the link below. Thank you in 
advance for your help. 

Before using this guide, read your instrument’s Getting Started Guide and the Xcalibur Data 
Acquisition and Processing User Guide to become familiar with the basic features of the 
Xcalibur data system such as the Home Page, Instrument Setup, and Processing Setup 
windows.

Related Documentation
Thermo Fisher Scientific provides the following documentation for the Xcalibur data system:

• Xcalibur Quantitative Analysis Getting Started Guide

• Xcalibur Data Acquisition and Processing User Guide

• Xcalibur Quan Browser User Guide

• Xcalibur Qual Browser User Guide

• Xcalibur Library Browser User Guide

• XReport User Guide

• Help from within the data system

Contents

• Related Documentation

• Safety and Special Notices

• Contacting Us

http://www.surveymonkey.com/s/PQM6P62 
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 To access the manuals from the data system computer

• From the Windows™ Start menu, choose All Programs (or Programs) > Thermo 
Xcalibur > Manuals.

• From the Home Page – Roadmap view of the Thermo Xcalibur data system, choose 
Help > Manuals from the menu bar. 

Thermo Fisher Scientific provides the manuals as PDF files.

Safety and Special Notices
Make sure you follow the precautionary statements presented in this guide. The safety and 
other special notices appear in boxes.

Safety and special notices include the following:

IMPORTANT  Highlights information necessary to avoid damage to software, loss of data, 
invalid test results, or information critical for optimal performance of the system.

Note  Highlights information of general interest.

Tip  Highlights helpful information that can make a task easier.
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Contacting Us
There are several ways to contact Thermo Fisher Scientific for the information you need. 

For Thermo Scientific™ products Access by phone, fax, email, or website

Technical Support (U.S.) Phone: 1 (800) 532-4752 Fax: 1 (561) 688-8736

Email: us.techsupport.analyze@thermofisher.com

Web—for product support, technical documentation, and knowledge bases:
www.thermoscientific.com/support

Customer Service
(Sales and service)

(U.S.) Phone: 1 (800) 532-4752 Fax: 1 (561) 688-8731

Email: us.customer-support.analyze@thermofisher.com

Web—for product information:
www.thermoscientific.com/lc-ms

Web—for customizing your service request:

1. From any Products & Services web page, click Contact Us.

2. In the Contact Us box, complete the information requested, scroll to the 
bottom, and click Send.

User Documentation Web—for downloading documents:
mssupport.thermo.com

1. On the Terms and Conditions web page, click I Agree.

2. In the left pane, click Customer Manuals.

3. To locate the document, click Search and enter your search criteria. For 
Document Type, select Manual.

Email—to send feedback directly to Technical Publications:
techpubs-lcms@thermofisher.com

Web—to complete a survey about this Thermo Scientific document:
www.surveymonkey.com/s/PQM6P62

mailto:us.techsupport.analyze@thermofisher.com
http://www.thermoscientific.com/en/support-landing/support.html
mailto:us.customer-support.analyze@thermofisher.com
http://www.thermoscientific.com/en/products/chromatography-mass-spectrometry.html
http://mssupport.thermo.com
mailto:techpubs-lcms@thermofisher.com
http://www.surveymonkey.com/s/PQM6P62
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1

Overview of Quantitative Analysis

The Xcalibur data system is a complete quantitative and qualitative analysis software package 
that you can use to acquire data specifically for analytes of interest, to perform confirmatory 
library searches, and to determine the concentration of analytes in samples. The Xcalibur data 
system interfaces with the XReport reporting package to print individual sample reports and 
sequence summary reports for analyses. For more information on XReport, refer to the 
XReport User Guide.

Quan Browser is a powerful and versatile utility for reviewing and reworking the following:

• Component peak identification and integration criteria

• Standards, QCs, blanks, and unknowns

• Calibration curves for quantitation standards

After making any changes, save the new results with an audit trail describing the reason for the 
change. 

Quan Browser incorporates a calibration curve display, peak integration, and results view 
where you can do the following:

• Process quantitation sequences

• Interactively edit processing parameters and audit the changes

• Create new files that keep track of processing results for individual raw files and include a 
copy of the method used to generate the results

Result files changed using Quan Browser do not affect the original processing method.

This chapter describes some of the basic principles and terminology of quantitation, and 
provides a brief overview of quantitation with the Xcalibur data system. 

Contents

• Acquiring and Quantitatively Processing Data

• Integrating and Identifying Chromatographic Peaks
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Acquiring and Quantitatively Processing Data 
Quantitative analysis is the process of measuring the amount of a particular component in a 
sample. With the Xcalibur data system, quantitative analysis usually involves the following 
steps:

1. Create an instrument method. 

The Xcalibur data system uses an instrument method to store a specific set of parameters 
used to operate the autosampler, LC pump or MS pump, gas chromatograph, mass 
spectrometer, PDA detector, and so on. 

For more information about creating an instrument method, refer to your hardware 
documentation. 

2. Create an acquisition sequence. 

An acquisition sequence identifies the position of the samples in an autosampler tray (if 
appropriate), the instrument method used to control the HPLC, GC/MS, or LC/MS 
instrument, and the directory and file names for the acquired data files.

For more information about creating an acquisition sequence, refer to the Xcalibur Data 
Acquisition and Processing User Guide.

3. Run the sequence to acquire the raw data files.

Run either one sample or a series of samples from the current sequence. 

For more information about running samples, refer to the Xcalibur Data Acquisition and 
Processing User Guide.

4. Create a processing method.

Create processing methods in the Processing Setup view. The data system uses a 
processing method to identify, detect, and integrate components in a chromatogram, 
generate calibration curves, quantify unknowns, and produce reports. The application 
contains several built-in report templates. Report templates have an (.xrt) file extension. 

For more information about creating a processing method, refer to the Xcalibur Data 
Acquisition and Processing User Guide.

5. Create a processing sequence by adding the processing method to the original acquisition 
sequence. 

A processing sequence contains a processing method, consists of a list of sample data files, 
and includes information on sample type and calibration or QC level. 

Note  The order of some of these steps is not rigid. For example, you can acquire and 
process a set of data files using a sequence that contains both an instrument method and a 
processing method, and you can print reports without previewing them first. For more 
information, refer to the Xcalibur Data Acquisition and Processing User Guides.
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6. Process a representative raw file or the entire sequence with the processing method by 
using the Batch Reprocess feature in the sequence Setup view. 

Processing a raw file produces a result file. Result files have an (.rst) file extension. For 
instructions on batch processing a sequence, refer to the Xcalibur Data Acquisition and 
Processing User Guide.

7. Review the processed data files. After the Xcalibur data system processes the raw data files, 
open the processed sequence in Quan Browser and evaluate the peak detection settings, 
the integration settings, and the calibration curve for each named component. As you 
evaluate the results of the processing method, you can modify some of its parameters in 
Quan Browser. If the processing method contains a report template, you can print reports 
from Quan Browser. 

8. Preview a report for a representative data file from the XReport reporting package.

To produce customized reports, open a representative result file (RST) in the XReport 
reporting package and create a report template.

9. Once you are satisfied with the way a report displays your data, add the report to the 
processing method, if you have not already done so, and batch process the sequence to 
generate printed reports.

Tip  The report templates provided with the Xcalibur software are generic and might 
not produce the results you expect. Preview a report in XReport before printing 
reports for an entire sequence. For information about creating and changing reports, 
refer to the XReport User Guide.
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Integrating and Identifying Chromatographic Peaks
The Xcalibur data system integrates chromatograms to separate the chromatographic peaks 
from the baseline noise, identify the beginning and end of each peak, identify the peak 
maxima, and calculate the area or height of each peak (see Figure 1). The data system uses one 
of the following three algorithms to detect and integrate the peaks in chromatograms: 
Genesis, ICIS, or Avalon. To integrate mass chromatograms, use either the Genesis (designed 
for legacy Xcalibur 1.0 studies) or the ICIS integration algorithm. To integrate UV/Vis and 
analog chromatograms, use the Avalon integration algorithm.

Figure 1. Integrated chromatographic peak, showing peak start and peak end markers

For LC data, the Xcalibur data system identifies peaks based on their retention times. The 
retention time of a peak is the time that elapses between the injection of the sample and the 
detection of the peak maxima. For GC data, the application can identify peaks based on either 
their retention times or their mass spectra.

During a sequence run, the retention times of chromatographic peaks can vary slightly. As a 
result, you must enter an appropriate retention time window for each peak, in addition to its 
expected retention time. A retention time window is a time range that brackets the discrete 
retention time setting. The appropriate retention time window for a chromatographic peak 
depends on several factors, including the width of the chromatographic peak and the 
specificity of the chromatographic method. Due to band broadening as the sample travels 
through the column, highly retained compounds produce wider chromatographic peaks. So 
in general, use a wider retention time window for late eluting compounds than for early 
eluting compounds. Figure 2 shows the effect of retention time on peak width. The 
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chromatogram shown in Figure 2 contains four peaks. The retention times and widths of 
these peaks are listed in the following table. In this example, hydrocortisone, which elutes at 
0.68 min, has a peak width of 0.2 min; whereas, progesterone, which elutes at 3.17 min, has a 
peak width of 0.6 min.

Figure 2. Integrated total ion current chromatogram (TIC) for steroids02.raw

Because the Xcalibur data system might detect more than one chromatographic peak within 
the specified retention time window, identify the target compound as either the highest peak 
in a chromatogram or the closest peak to the expected retention time. Use the Genesis and 
ICIS integration algorithms (used for mass spectral data) to rule out peaks below a specified 
signal-to-noise ratio.

Quantitative analysis of samples containing unknown amounts of the target component is 
achieved by first calculating the peak area or height and then computing and applying the 
appropriate response to the equation derived from the calibration curve. This process provides 
an estimate of the amount of the unknown component. The precision of the measurement 
depends on the quality and, to a lesser extent, the quantity of the calibration data.

The detection limit of the quantitation method is the lowest concentration of analyte in a 
sample that can be detected but not necessarily calculated as an exact value. The lower and 
upper quantitation limits are the lowest and highest concentrations of analytes in a sample 
that can be measured with an acceptable level of accuracy and precision, respectively. In an 
analytical method, the highest concentration calibration standard defines the upper 

Compound Retention time
(min)

Baseline peak width
(min)

hydrocortisone 0.68 0.2

deoxycorticosterone 1.40 0.3

methyltestosterone 1.99 0.4

progesterone 3.17 0.6
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quantitation limit. The quantitation range is the range of concentration between the lower 
and upper quantitation limits (including these limits) that can be reliably quantified time after 
time with acceptable levels of accuracy and precision through the use of a 
concentration-response relationship.

There are two basic quantitation techniques:

• External standard (ESTD) quantitation

• Internal standard (ISTD) quantitation

The chosen method determines the calculation method, both for the generation of the 
calibration curves and for subsequent quantitation. 

For information about using the two basic quantitation techniques, see these topics:

• Using External Standards

• Using Internal Standards

Using External Standards 

An external standard (ESTD) is a separate sample that contains a known amount of the target 
compound. To perform an ESTD calibration, prepare a set of standard solutions containing a 
known amount of the target compounds. After you inject these solutions, the data system 
analyzes the resulting chromatograms and constructs a calibration curve for each target 
compound by plotting the magnitude of the detector’s response as a function of the amount 
of the target compound according to the following equation:

Responsecal = f (Amountcal)

Where: 

f = curve type

Amountcal = amount of calibration standard

Responsecal = response for calibration standard

The data system determines the amount of the target compounds in each unknown by 
comparing the magnitudes of their responses to the calibration curves (see Figure 3).

Use ESTDs if all compounds of interest can be assayed by using a single set of external 
standards. This approach offers time- and cost-effective quantitation for applications using 
high precision autosamplers and traditional UV/Vis detectors. However, for some types of 
analyses, this method cannot achieve the highest level of precision and accuracy. Depending 
on the instrumentation, variations in analyte and solution stability, injection reproducibility, 
and matrix interference can lead to lower precision levels in the external standard method than 
in the internal standard method.
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Figure 3. Calibration curve generated by using an external standard

In general, the external standard calibration is an effective quantitation technique; however, if 
one or more of the following problems exist, consider using the internal standard calibration 
technique instead.

• Lack of injection reproducibility

• Changes in analyte solution volume

• Matrix and coeluter interference (both suppression and enhancement)

• System instability

• Variations in the source conditions
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Using Internal Standards 

An internal standard (ISTD) is a component that is added to a sample to act as a response 
reference for one or more non-ISTD components in the sample. The concentration or 
amount of an ISTD in any standard or unknown sample typically remains constant.

Because quantitative mass spectrometric analysis usually involves multiple steps, the total 
error in the analysis results from the accumulation of errors at each step. In general, sample 
handling errors account for a larger fraction of the total error than detector errors do. 
Fortunately, the internal standard method can reduce both sources of error. For example, 
internal standards can correct for variations in a component’s peak area that are caused by the 
following:

• Lack of injection reproducibility

• Changes in analyte solution volume

• Matrix and coeluter interference (both suppression and enhancement)

• System instability

• Variations in the source conditions

For maximum precision, add the ISTD component as early as possible to the start of the 
sample workup, particularly in those quantitative methods that require sample manipulations 
such as extraction, cleanup, and dilution. Since the ISTD and non-ISTD components are 
analyzed together and since the ISTD is known and quantifiable, the internal standard 
quantitation approach corrects for injection and other sample handling errors. The ISTD 
must behave chemically in an identical or similar manner to the target compound through the 
extraction, cleanup, and analytical processes.

You can also add the ISTD component as the last step of sample preparation prior to the 
sample’s use to compensate for fluctuations in the reproducibility of the sample injection. 

For the internal standard calibration method, the Xcalibur data system constructs a 
calibration curve from a set of standard solutions that contain a range of concentrations for 
the target compounds and a fixed concentration for each internal standard compound. For 
each target compound, the data system plots the detector response ratios for the target 
compound and its associated internal standard compound as a function of the corresponding 
target compound concentration. The data system then determines the concentration of the 
target compounds in the unknown samples by using the calibration curve. Figure 4 shows the 
interpolation of the target compound amount in an unknown from calibration curve 
constructed using the internal standard method.
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Figure 4. Calibration curve generated by using the internal standard method

The calibration curve is determined by the following equation:

(Response RatioTargetCal/ISTD) = f (AmountTargetCal)

Where:

AmountTargetCal = Amount of target compound in the calibration standards

Response RatioTargetCal/ISTD = ratio of the responses of the target compound to the 
internal standard compound in the calibration standard

f = equation of the calibration curve according to the selected fit type

Ideally, an ISTD is closely related to the target component in terms of its physical and 
chemical properties. If the ISTD is used only to compensate for injection reproducibility or 
changes in the analyte solution volume, it must possess a similar retention (k) to the target 
component, but it does not need to be chemically similar to the target component. It must be 
pure, not present in the sample, and inert towards the components of the sample. ISTD 
components are typically analogs, homologues, or isomers of the target non-ISTD 
component. An ideal ISTD is a structural or isotopically-labeled analog of one of the target 
components. Stable isotope-labeled ISTDs act almost identically to the analyte throughout 
sample manipulation and with regard to ionization tendencies and fragmentation. Internal 
standards labeled with two or more deuterium (D) atoms are frequently used for LC/MS. 

There can be any number of ISTD components in a sample, but each non-ISTD component 
can be calibrated against only one ISTD component.
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2

Quan Browser Overview

This chapter describes how to use Quan Browser to review processed quantitation sequences. 
It explains the properties and uses of each component within the Quan Browser window. The 
Xcalibur Qual Browser User Guide describes how to use the Qual Browser window to review 
raw files. The Xcalibur Library Browser User Guide describes how to create user libraries of 
mass spectral data and run searches of mass spectral libraries.

Understanding How Quan Browser Works
Using the Quan Browser application, you can step through a sequence of processed samples 
and review the results for each component in each sample.

The Xcalibur data system has the following quantitation features:

• Calibration Replicates

• Named Calibration File

• Brackets and Groups for Sequences

Calibration Replicates

Calibration replicates are multiple injections of the calibration mixture at the same calibration 
level or amount. These standard samples all contain the same amount of target compound, so 
they correspond to the same calibration level. Choose replicates to include or exclude from the 
calibration curve by using the calibration curve view. 

Contents

• Understanding How Quan Browser Works

• Starting Quan Browser

• Quan Browser Window Overview

• Saving Changes Made in Quan Browser



2 Quan Browser Overview
Understanding How Quan Browser Works

12 Xcalibur Quan Browser User Guide Thermo Scientific

Named Calibration File

After creating a sequence with the Bracket Type set to None, specify a calibration file name in 
the Calibration File box. Although in theory a different calibration file name for every sample 
is possible, in practice only one name per sequence is common.

Named calibration files are not available with bracketed sequences.

Brackets and Groups for Sequences

This section describes different bracket types and when to use them to get a specific result.

• Unbracketed Sequence

• Open Bracket Sequence

• Nonoverlapping Bracket Sequence

• Overlapping Bracket Sequence

To set up sequence bracketing for the None, Non-Overlapped, and Overlapped bracket types, 
you must use the New Sequence Template dialog box. When you manually set up a sequence 
using the sequence table in the Sequence Setup view, you can only create an open bracket 
sequence. You cannot use a calibration file or add more than one processing method to an 
open bracket sequence. For information about using the New Sequence Template dialog box 
to set up a sequence, refer to the Xcalibur Data Acquisition and Processing User Guide.

Unbracketed Sequence

The Xcalibur data system processes an unbracketed sequence (None bracket type) using a 
procedure known as the continuing calibration method. Each time the application processes 
an unbracketed sequence, it creates or updates the calibration files named in the sequence.

Select this process and avoid using Std Clear (Standard Clear) to add replicate data 
incrementally to a calibration file without discarding the existing replicate data.

The Quan Browser application breaks down unbracketed sequences into logical groups that 
are somewhat analogous to brackets. It does this by first ordering the samples chronologically 
with respect to acquisition date and time. It then examines the sequence and starts a new 
group whenever it encounters a standard. The group ends at the nonstandard sample that 
immediately precedes the next standard found.

The first group always starts with the first sample, even if it is not a standard. The last group 
always ends with the last sample. Further, a Std Clear always starts a new group, even if no 
intervening nonstandard sample has been found following one or more Std Updates.
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The Xcalibur data system forms additional logical groups if different named calibration files 
have been specified in the Cal File entries of the sequence. Each cal file entry causes a new 
group to be formed. Because using multiple-named calibration files is not typical, their use is 
not considered any further in this document, but should be deducible from the discussions on 
groups.

As the Quan Browser application processes each group, it quantifies samples against the 
current calibration curve. The application processes each standard that it encounters by either 
replacing (sample type set to Std Clear) or adding to (sample type set to Std Update) the 
calibration replicate list, generating a new calibration curve.

Quan Browser processing closely emulates that of batch processing (either batch processing 
directly after acquisition or, subsequently, as a batch process operation). If the Quan Browser 
application cannot find or open a specified calibration file, the Xcalibur data system displays 
this message in the Calibration File edit box:

Cal File Unavailable – Using Embedded Calibration 

The Quan Browser application takes replicate data from the data stored in the result file. In 
most cases this data is identical to the data contained within the original calibration file.

Once the Quan Browser application has set up the groups, they are independent and are 
effectively treated as brackets. In other words, changes in one group do not affect any other 
group, unlike in batch processing where subsequent groups might well be affected.

The following list illustrates the procedure (for a single-named calibration file):

Sample 1 Unknown Group 1 start

Sample 2 Unknown Group 1 end

Sample 3 Std Clear Group 2 start

Sample 4 Unknown Group 2 end

Sample 5 Std Update Group 3 start

Sample 6 Std Update

Sample 7 Unknown

Sample 8 Unknown 

Sample 9 Blank

Sample 10 QC Group 3 end

Sample 11 Std Update Group 4 start/end

Sample 12 Std Clear Group 5 start

Sample 13 Blank Group 5 end
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Open Bracket Sequence

For an open bracket sequence (Open bracket type), the Quan Browser application creates a 
replicate list directly from all standard samples in the sequence without using any calibration 
data embedded in result files.

When you open a single result file in the Quan Browser application, the application treats it as 
a sequence with only one entry and lists the sample type as Unknown. To show the calibration 
curve used to quantitate the sample, the application creates the replicate list from the 
embedded information.

Nonoverlapping Bracket Sequence

For a non-overlapping bracket sequence (Non-Overlapping bracket type), the Quan Browser 
application creates a separate replicate list for each bracket. The application creates each 
replicate list directly from all standard samples in the bracket without using any calibration 
data embedded in result files.

Overlapping Bracket Sequence

For an overlapping bracket sequence (Overlapping bracket type), the Quan Browser 
application creates a separate replicate list for each bracket. The application creates each 
replicate list directly from all standard samples in the bracket without using any calibration 
data embedded in result files.

Exceptions occur for shared standard samples between brackets. When a standard that is 
shared undergoes a change, that change is reflected in all brackets that contain that standard. 
When a shared standard sample is deleted, the application deletes the standard sample in all 
brackets that contain that standard sample and adjusts the replicate lists for all brackets.

When you add a sample as a standard to any bracket, the application adds it to the replicate 
list automatically. To add a standard sample as a shared standard sample, you must add it 
separately to each bracket.

The exclusion status of the replicates is independent for each bracket. Even shared samples 
might be excluded in one bracket but not in another. This is the only exception to a shared 
sample having identical settings.
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Starting Quan Browser
Use the Quan Browser window to review the results of a quantitative analysis.

 To start the Quan Browser application

1. Do one of the following:

• On the Home Page – Roadmap view, click the Quan Browser icon, .

• From the Instrument Setup window, click the Home Page icon, , in the toolbar. 
Then, click the Quan Browser icon.

• From the Home Page or Processing Setup windows, choose GoTo > Quan Browser. 

At startup, Quan Browser displays the Open dialog box so you can select an existing file. 
If you do not want to select a file, click Cancel in the Open dialog box to close Quan 
Browser.

The Quan Browser application supports these file types:

• Sequence files (SLD)

• Result files (RST)

• Quan Browser files (XQN)

Quan Browser handles result files as single entry sequences. 

2. Select a file in the Open dialog box.

When you select a sequence file, the application checks that all the associated raw and 
result files are available. When it encounters a problem with the sequence file, the 
application provides information about the likely cause in a warning dialog box and 
prompts you to exit the application or select a different file. 

After the application verifies that the files exist and can be opened, the View Sample 
Types dialog box opens (see Figure 5). 

Figure 5. View Sample Types dialog box

The two options provided in the View Sample Types dialog box determine how the 
results grid is configured at startup.
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3. Select one of these options:

• To display only Standards and QCs in the Quan Browser results grid, select the Show 
Standard and QC sample types option. Blanks and Unknowns do not appear in the 
grid. Click either the Standards or QCs tab.

• To display Standards, QCs, Blanks, and Unknowns in the Quan Browser Grid view, 
select the Show All sample types option. Click one of the following tabs: All, 
Standards, QCs, Blanks, or Unknowns. 

The View Sample Types dialog box includes a Don’t ask again check box. When you 
select this check box, the dialog box is not displayed when you start subsequent sessions in 
Quan Browser and the current selection becomes the default.

4. To start the session, click OK. Quan Browser loads the specified sequence or file and 
configures the results grid using your selected viewing option.

Note  To make this and all other Don’t Ask Again-type dialog boxes active, choose 
Options > Enable Warnings.
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Quan Browser Window Overview
The Quan Browser window has the following features (see Figure 6):

• Component List

• Results Grid

• Chromatogram Plot and Companion Views

For more information about the Quan Browser window, see Appendix A, “Quan Browser 
Window.” 

Figure 6. Quan Browser window 

Component List

The component list displays all the components within the current bracket sorted by 
retention time. To update the chromatogram plot view and the companion view with data for 
a specific component, click the component name. For more information about the 
component list, see “Quan Browser Component List” on page 88.

Title bar

Toolbar

Menu bar 

Status bar

Component listResults grid

Chromatogram view Companion view
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Results Grid

The results grid is made up of the Bracket in Use list, the Calibration File box, and a sequence 
table. Each row of the sequence table defines a result file and associated parameters. Use the 
tabs at the bottom of the window to display all of the sequence samples or a subset of the 
sequence samples. 

The results grid is made up of these key areas:

• Bracket/Group in Use

• Calibration File

• Results Grid

Bracket/Group in Use

For bracketed sequences, the Brackets in Use list shows the available brackets in sequential 
order. The data system selects the first bracket in the list when the file is first loaded into 
Quan Browser and displays the samples within this bracket in the results grid.

When you load an unbracketed sequence, the samples are broken into logical groups. The 
Groups in Use list shows the available groups.

Selecting a new bracket or group from the list refills the results grid with the samples from the 
selected bracket or group. The application updates all the other Views and dialog boxes 
automatically.

For more information, see “Brackets and Groups for Sequences” on page 12 and 
“Bracket/Group In Use List” on page 96.

Calibration File

This read-only box shows the calibration method applied to the current bracket or group. 
When the calibration information for the current bracket is obtained from the embedded 
processing method and not from a separate calibration file, the box displays Embedded 
Calibration.

For unbracketed sequences, the box displays the name of the calibration file associated with 
the current group in the sequence. 

To change the named calibration file for an unbracketed sequence, choose File > Replace 
Calibration. This option is not available for bracketed sequences.
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Results Grid

Figure 7 shows the results grid and its shortcut menu.

Figure 7. Results grid table and shortcut menu

For information about the columns in this view and the shortcut menu, see “Quan Browser 
Results Grid” on page 84. 

Chromatogram Plot and Companion Views

The chromatogram plot view displays the chromatogram for the currently selected 
component from the currently selected result file.

Figure 8 shows the chromatogram view and shortcut menu.

Figure 8. Chromatogram view and shortcut menu



2 Quan Browser Overview
Quan Browser Window Overview

20 Xcalibur Quan Browser User Guide Thermo Scientific

When a filter is stored within the embedded processing method for the current compound, 
the application applies it to the chromatogram. Adjust the chromatogram plot using the 
Zoom menu commands or icons in the toolbar.

The type of integration used appears in the results grid, but can be overridden. The three 
types are Method Settings, User Integration, and Manual Integration. Change the Integration 
method by using the User Identification Settings dialog box or by manually integrating a 
peak. For more information, see “Using the User Identification Settings Dialog Box” on 
page 37 and “Integrating Chromatogram Peaks Manually” on page 46.

The companion view is located to the right of the chromatogram plot view (its companion) in 
the lower right corner of the Quan Browser window. In the companion view you can choose 
either the spectrum plot view or the calibration curve view.

Figure 9 shows the calibration curve view and shortcut menu.

Figure 9. Calibration curve view and shortcut menu
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Saving Changes Made in Quan Browser
In the Quan Browser window, you can do the following:

• Modify result files (RST).

• Modify processing methods (PMD).

• Create Xcalibur QuanBrowser files (XQN).

• Export the quantitation results in the results grid to a Microsoft™ Excel™ spreadsheet. 

• Set up new sample sets in the results grid by adding or deleting samples; however, you 
cannot export the modified sample set as a new sequence file (SLD). To continue working 
with a modified sample set, you must save your changes to an Xcalibur Quan file (XQN).

• Evaluate manual integration settings for component peaks; however, you cannot save the 
results of manual integration to a result file. To continue working with manually 
integrated peaks, you must save your changes to an Xcalibur Quan file (XQN).

For information about changing some of the information associated with the result file, such 
as the sample type, sample name, or calibration level, see “Making Changes in the Results 
Grid” on page 27. For information about changing the peak identification, detection, and 
integration settings, see “Viewing and Changing Peak Identification, Detection, and 
Integration” on page 33. For information about changing the calibration settings, see 
Chapter 5, “Working with the Calibration Settings.” 

 To save changes to the result files

After you make changes to result files, save the changes by choosing File > Save All.

 To save the changes to an Xcalibur QuanBrowser file

1. Choose File > Save.

The Save As dialog box opens.

2. Select a directory in the Save In box, and type a name in the File Name box.

3. To save the file and close the Save As box, click Save. 
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 To save the changes to an Xcalibur QuanBrowser file and set up an audit trail

1. After making changes, save a file with the changes by choosing File > Save As. 

The File Summary Information dialog box opens (Figure 10). 

Figure 10. File Summary Information dialog box

2. Enter a comment clearly identifying the changes you made and click OK. 

The Save As dialog box opens. The QuanBrowser (XQN) file type is the only type listed 
in the Save as Type list (Figure 11).

Figure 11. Save As dialog box
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3. Type a name for the Xcalibur QuanBrowser file in the File Name box.

4. To save the file and close the Save As box, click Save.

 To save user integration settings to a processing method

1. Apply the user integration settings to one sample or to all of the samples.

2. If you applied the user integration settings for a component peak to a specific sample, and 
you want to save those settings to a processing method, select the sample in the results 
grid. If you applied the user integration to all of the samples, you do not need to select a 
specific sample in the results grid.

3. Choose File > Export Method.

The Save As dialog box opens.

4. Browse to the directory where you want to store the processing method.

5. If the selected directory folder contains processing methods, the box under the File Name 
box displays the method names.

6. Select the processing method that you want to modify or type a new name in the File 
Name box.

7. Click OK.

 To export the information in the results grid to an Excel spreadsheet

1. Do one of the following:

• Choose File > Export Data to Excel > Export Short Excel Report.

–or–

• Choose File > Export Data to Excel > Export Long Excel Report.

The Excel application opens with the report displayed behind the Quan Browser window, 
and Quan Browser automatically saves the spreadsheet to the current working directory.

2. Save the spreadsheet.
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3

Working with the Quan Browser Results Grid

This chapter describes how to modify the Quan Browser sequence by changing the sample 
type for each row, changing the level for standards and QC samples, adding and deleting rows, 
and changing the sort order. This chapter also describes how to use the Add Sample dialog 
box to change several parameter settings in a result file, including the Sample ID, Sample 
Name, ISTD Corr Amt, and Dilution Factor.

For information about excluding standards from the calibration curve for a component, see 
“Excluding Data Points from the Calibration Curve” on page 59.

Reviewing and Reworking the Results Grid
The results grid displays information about each data file in the quantitation sequence. You 
can review the effect of changing some of the grid parameters, including the sample type, 
calibration and quality control levels, internal standard correction amount, and dilution 
factor.

 To review and edit a sequence

1. To open a sequence in the Quan Browser window, do the following:

a. Choose File > Open.

The Open dialog box appears.

Contents

• Reviewing and Reworking the Results Grid

• Reviewing the Peak Status Column

• Making Changes in the Results Grid

• Adding and Removing Samples

• Hiding or Displaying Columns

• Changing the Sort Order
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b. In the File of Type list, select one of the following file types:

• Sequence List Files (SLD)

• Result Files (RST)

• Quan Browser Files (XQN)

c. Browse to and select the file of interest and click Open.

When you open a bracketed sequence, the Bracket in Use list is active and displays 
the available brackets. The results grid displays the samples in bracket 1. 

When you open an unbracketed sequence, the Group in Use list is active and displays 
groups broken up logically. For more information about brackets and groups, see 
“Bracket/Group In Use List” on page 96. 

When you open a result file, the application creates a one-row sequence.

2. Inspect the sequence. If the sequence contains more than one bracket, inspect each 
bracket. Verify that the correct samples are listed in the results grid. Ensure that each 
sample in the sequence is properly associated with its sample type and that the 
appropriate levels are associated with the standards and QC samples. Check the status in 
the Peak Status column as described in “Reviewing the Peak Status Column” on page 27.

3. Make changes as appropriate.

• To change the sample type or the level for a standard of QC sample, follow the 
instructions in “Making Changes in the Results Grid” on page 27.

• To add or remove samples, follow the instructions in “Adding and Removing 
Samples” on page 28.

• To hide or show columns, follow the instructions in “Hiding or Displaying 
Columns” on page 31.

• To change the sort order of the sequence rows, follow the instructions in “Changing 
the Sort Order” on page 32.

4. To save your changes, do the following:

• To save your edits to an Xcalibur Quan file (XQN), choose File > Save.

The resulting Xcalibur Quan file contains all the necessary information required to 
recreate the current Quan Browser session.

• To save your edits to an Xcalibur Quan file and add information to the audit trail, 
choose File > Save As. 

• To update and save the result files, choose File > Save All.

The application updates the result files with the new information and current time 
stamp.
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Reviewing the Peak Status Column
If the sequence contains QC samples, you can check the stability of the chromatographic 
method by viewing the results in the Peak Status column of the results grid in the Quan 
Browser window. If the calculated amount for the QC sample differs by more than the 
specified percentage in the processing method, the peak status is listed as QC Failed.

 To check the stability of a sequence run that contains QC samples

1. Open the sequence of acquired and processed data in the Quan Browser window.

2. Click the QCs tab.

3. In the component list, select a target component.

4. View the results in the Peak Status column of the results grid.

The three possible results for a QC sample are as follows:

• Low: if the %Difference is < 0

• High: if the %Difference is > 0

• Fail: if the %Difference is > the user-specified percentage test value

Making Changes in the Results Grid
In the results grid, you can change the selections in the Sample Type, Level, and Integration 
Type columns, you can exclude or include calibration data points, and you change the text in 
the Sample Name column by using the Add Sample dialog box.

 To change the sample type

Click the Sample Type column to display the sample type list and select a sample type 
from the list.

 To change the level of a standard or QC sample

Click the Level column to display the Level list and select a sample type from the list.

 To exclude data points from the calibration curve

Select the check boxes in the Exclude column for each calibration standard that you want 
to exclude.

Note  For information about setting up the QC information in the processing method 
and the QC levels in the sequence table, refer to the Xcalibur Data Acquisition and 
Processing Guide



3 Working with the Quan Browser Results Grid
Adding and Removing Samples

28 Xcalibur Quan Browser User Guide Thermo Scientific

 To change the text in the Sample Name column for a sample

1. Delete the sample from the results grid by right-clicking the sample and selecting Delete 
Selected Samples from the shortcut menu.

2. Add the sample back to the results grid by following the instructions in “Adding and 
Removing Samples” on page 28.

 To change the integration type for a sample component

Do one of the following:

• To change the type from Method Settings to Manual, manually integrate a peak as 
described in “Integrating Chromatogram Peaks Manually” on page 46. Then, click 
the Integration Type column to display the integration type list and select Manual 
from the list.

• To change the type from Method Settings to User Integration, set up new integration 
settings by using the User Identification Settings dialog box. Then, click the 
Integration Type column to display the integration type list and select User Settings 
from the list. 

When you select User Integration, Quan Browser integrates the component peak by 
using the settings in the User Identification Settings dialog box. For information 
about using the User Identification Settings dialog box, see “Using the User 
Identification Settings Dialog Box” on page 37.

–or–

• To change the type from Manual or User Integration to Method Settings, Then, click 
the Integration Type column to display the integration type list and select Manual 
from the list.

When Method Settings is selected in the Integration Type list, Quan Browser 
integrates the component peak by using the settings in the current processing 
method.

Adding and Removing Samples
To change the sample name for a sample in the results grid, delete the sample from the grid, 
and then add it back to the grid by using the Add Sample dialog box. For more information, 
see “Add Sample Dialog Box” on page 95.

 To add samples to the results grid

1. To minimize data entry, select a sample in the results grid that it similar to the sample or 
samples that you are adding.

2. Right-click the results grid to display the shortcut menu and choose Add Sample.

The Open Rawfile dialog box opens.
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3. Browse to the appropriate folder and select the raw file or raw files to add to the sequence 
and click Open. 

The Add Sample dialog box opens with the parameter settings from the data file that you 
selected in the results grid. By default, the Use Sample Name and Comment from 
Selected RawFile(s) check box is selected (Figure 12). 

Figure 12. Add Sample dialog box

4. Review the text entries and the Sample Type and Level selections.

Tip  You cannot edit the following parameters in the results grid: Sample ID, ISTD 
Corr Amt, Dilution Factor, Sample Name, and Comment. To enter different values 
for each sample, add one sample at a time.

Note  After you add samples to the results grid, you can change only the Sample Type, 
the Level for a QC or Standard sample type, and whether a calibration standard is 
included or excluded from the calibration curve for a component.

Settings from the 
sample selected in 
the results grid
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5. For the Sample Name and Comments parameters, do one of the following:

• To use the information that is stored in the raw files for these parameters, keep the 
Use Sample Name and Comment from Selected RawFile(s) check box selected.

When you add the sample or samples to the results grid, the data system populates 
the Sample Name and Comments fields for the added samples with the information 
embedded in the raw files.

–or–

• To change the Sample Names and Comments settings for the sample or samples that 
you are adding, clear the Use Sample Name and Comment from Selected RawFile(s) 
check box. Then type the appropriate text in the Sample Name and Comments 
boxes.

When you add the sample or samples to the results grid, the data system populates 
the Sample Name and Comments fields with your text entries. When you add 
multiple samples at a time, the data system uses the same Sample Name and 
Comment for all of the added samples.

6. For the remaining parameters in the Add Samples dialog box, do the following:

• In the Sample Type list, select the appropriate sample type.

• In the Levels list, select the appropriate level for standard or QC sample types.

• In the Sample ID box, type an appropriate sample ID.

• In the ISTD Corr Amt box, type a value.

The acceptable range is from 0 to 10 000.

• In the Dilution Factor box, type a value.

The acceptable range is from 0.001 to 1000.

7. Click OK.

The new sample or samples appear in the results grid according to the sort order specified 
in the Quantitation results Sorting Order dialog box. When you add a standard, Quan 
Browser recalculates the calibration curve for the bracket and the calculated amounts for 
the samples within the bracket. For information about changing the sort order, see 
“Changing the Sort Order” on page 32 and “Quantitation Results Sorting Order Dialog 
Box” on page 119.

8. When you finish you edits, save your changes as described in step 4 of “Reviewing and 
Reworking the Results Grid” on page 25.

Note  If the processing method associated with the selected sample in the results 
grid does not specify any QC levels, you cannot select the QC sample type.
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 To remove samples from the sequence

1. Select the row or rows in the sequence to delete.

2. Right-click the sequence to display the shortcut menu and choose Delete Selected 
Samples.

3. When you finish your edits, save your changes as described in step 4 of “Reviewing and 
Reworking the Results Grid” on page 25.

Hiding or Displaying Columns
The Quan Browser results grid contains up to 17 columns. Use the Result List Column 
Hiding dialog box (Figure 13) to display some or all of these columns.

Figure 13. Result List Column Hiding dialog box 

 To change the columns that the results grid displays

1. Right-click the results grid and choose Columns from the shortcut menu. 

The Result List Column Hiding dialog box opens.

2. Select the check box for a column heading to display the column in the results grid. Clear 
the check box to hide the column in the results grid.

3. Click OK to save your changes and close the dialog box.
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Changing the Sort Order
Use the Quantitation Results Sorting Order dialog box to change the order of the result data 
files in the results grid.

 To change the sort order for entries in the results grid

1. Right-click the results grid and choose Set Sorting Order from the shortcut menu. 

The Quantitation Results Sorting Order dialog box opens (Figure 14).

Figure 14. Quantitation Results Sorting Order dialog box 

2. To choose a heading for the primary sort of the results grid, select any of the following 
column headings or file properties: 

By default, the data system sets the first order sort to the acquisition date of the file. Select 
and sort with any of these sort options even if the corresponding column is not currently 
displayed. For example, you can sort by Sample Type, even if you have selected the 
Sample Name check box in the Result List Column Hiding dialog box. 

3. Set any remaining column headings or file properties as the second and third sort criteria, 
even if the column is currently hidden.

4. To replace the default sorting criteria with your new selections, click Save As Default.

5. To sort the results grid, click OK.

• <none> 

• %Difference 

• %RSD 

• Acquisition Date 

• Area/Height 

• Area/Height Ratio 

• Exclude 

• File Name 

• Integration Type 

• Level Name 

• Peak Status 

• Sample ID 

• Sample Type 
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4

Working with Peak Identification and Detection

The chromatogram plot view displays the chromatogram for the currently selected 
component from the currently selected result file. Most of the commands for manipulating 
the chromatogram plot view are available from a shortcut menu. For information about the 
shortcut menu, see “Quan Browser Chromatogram Plot View” on page 88.

Viewing and Changing Peak Identification, Detection, and Integration
After you acquire and process data files in the Sequence Setup view, use the Quan Browser 
window to review the results of peak identification, detection, and integration. 

 To review and rework peak identification, detection, and integration in Quan 
Browser

1. In Quan Browser, open a file (result file, sequence file, or Xcalibur Quan file), select a 
component in the component list, and select a sample in the results grid.

2. Right-click the chromatogram view and choose Show Peak Info from the shortcut menu. 

The Peak Information dialog box opens. 

Contents

• Viewing and Changing Peak Identification, Detection, and Integration

• Setting the Display Options for the Chromatogram and Spectrum Plot Views

• Viewing Peak Information

• Using the User Identification Settings Dialog Box

• Integrating Chromatogram Peaks Manually

• Using the Spectrum Plot Companion View

• Reviewing Spectrum Search Results for GC/MS Data
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3. Review the chromatogram peak data in these areas:

• The properties of the detected peak on the Info page

• The integration information and flags on the Flags page

• The System Suitability test results on the Suitability page

• The spectrum for the peak apex scan on the Spectrum page

For more information, see “Viewing Peak Information” on page 35.

4. Adjust the peak detection and integration in the chromatogram plot view:

• Change the detection or integration settings. See “Using the User Identification 
Settings Dialog Box” on page 37. 

• Manually integrate peaks. See “Integrating Chromatogram Peaks Manually” on 
page 46. 

• Change chromatogram peak labeling. To change the labels, right-click the 
chromatogram plot view and choose Display Options from the shortcut menu. In 
the Display Options dialog box, click the Labels tab. On the Labels page, select the 
labels to display.

5. To view spectra across the chromatogram, do the following:

a. Display the spectrum plot view by doing one of the following:

• From the Quan Browser menu, choose View > Set Companion View > Show 
Spectrum Plot. 

• Right-click the companion view and choose Show Spectrum Plot from the 
shortcut menu.

b. Pin the spectrum plot view. Then, click points of interest in the chromatogram view 
to view the corresponding spectrum.

For more information, see “Using the Spectrum Plot Companion View” on page 48.

6. To do a detailed qualitative analysis of the chromatogram, right-click the data file of 
interest in the results grid and choose Send to Qual Browser from the shortcut menu.

The Qual Browser window opens and displays the selected result file. For more 
information about using Qual Browser, refer to the Xcalibur Qualitative Analysis User 
Guide.
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Setting the Display Options for the Chromatogram and Spectrum Plot 
Views

With the exception of the Composition options for the spectrum view, the display options for 
the chromatogram plot and spectrum plot views in Quan Browser are the same as those for 
the chromatogram and spectrum views in Qual Browser. 

For information about changing the display options for the chromatogram and spectrum 
views, refer to the Xcalibur Qualitative Analysis User Guide.

Viewing Peak Information
Quan Browser displays information about the currently displayed component peak, qualifier 
ion, or spectrum candidate in the Peak Information dialog box. The title bar contains the 
component name. 

For more information about the Peak Information dialog box, see “Peak Information Dialog 
Box” on page 108.

 To view the peak information

1. In the component list, select the component of interest.

2. Right-click the chromatogram view and choose Show Peak Info from the shortcut menu.

The Peak Information dialog box opens (Figure 15).

The parameters in this dialog box are read-only. If you select other components or 
samples, the dialog box updates the peak information for the displayed component 
chromatogram peak.

Figure 15. Info page – Peak Information dialog box
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 To check the validity of a chromatographic peak

1. Open the Peak Information dialog box for the component of interest as described in “To 
view the peak information” on page 35.

2. Click the Suitability tab. 

The Suitability page opens (Figure 16).

Figure 16. Suitability page of the Peak Information dialog box

Use the parameters on the Suitability page to determine if the LC column is degrading 
and to identify suspicious peaks eluting at the same time as the target compound. 
Suspicious peaks due to highly retained compounds from a previous injection tend to 
have a broader than expected peak profile. Tailing peaks frequently indicate a degrading 
LC column.

There are three possible results for each test: Passed, Failed, or Not Tested.

To change the system suitability criteria for a component peak, you must change the 
criteria on the System Suitability page of the Processing Setup – Quan view, and then 
reprocess the raw data file or the sequence file from Sequence Setup view. For more 
information about setting the system suitability parameters in the processing method for 
a quantitative analysis, refer to the Xcalibur Data Acquisition and Processing User Guide.
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Using the User Identification Settings Dialog Box
When you first open a sequence in Quan Browser, the application gets peak detection, 
calibration, and quantification information from the result file.

Within Quan Browser, use the User Identification Settings dialog box to test the effect of 
different parameter settings. This dialog box duplicates the parameters available on the 
Identification and Detection pages in the Quan view of Processing Setup.

For more information about this dialog box, see “User Identification Settings Dialog Box” on 
page 129.

 To test and change the identification, detection, and integration criteria for a 
component peak

1. Review the displayed data for the selected component to determine if the results are 
consistent with your expectations: 

• Are there peaks that were not found?

• Are neighboring peaks resolved?

• Are tailing peaks detected properly?

2. To modify the identification and detection criteria, right-click the chromatogram plot 
view and choose User Peak Detection Settings from the shortcut menu. 

The User Identification Settings dialog box opens with the Identification page displayed 
(see Figure 17 on page 39).

3. Make changes as appropriate:

• To change the chromatogram information or the peak detection algorithm, or to 
adjust the retention time window, change the settings on the Identification page. 

For more information, see “Setting the Identification Values” on page 38.

• To change the detection settings, click the Detection tab and change the settings on 
the Detection page. 

For more information, see “Setting the Detection Parameters” on page 40.

• If you have identified problems with noise in the peak, unresolved peaks, or peak 
tailing, click the Algorithm Integration tab and change the settings on the 
Integration page.

For more information about the parameters on the Integration page, see “Integration 
Page – User Identification Settings Dialog Box” on page 139.
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• If baseline noise is interfering with peak identification or integration, modify the 
settings on the Algorithm (Genesis or ICIS) Advanced page. Use advanced options 
only if the standard options do not provide sufficiently selective detection criteria. 

For more information about the advanced integration parameters, see “Advanced 
Page – User Identification Settings Dialog Box” on page 145.

• To view or change the settings on the Flags page, click the Flags tab. 

For more information, see “Setting the Flags Values” on page 45.

4. Click Apply to apply the new setting to the selected sample component or Apply to All 
to apply the new settings to all of the samples in the current bracket.

5. Click OK to close the dialog box.

6. To save the new settings, do the following:

• To export your settings as a new processing method, choose File > Export Method.

• To save the settings in a Quan Browser file (XQN), choose File > Save or File > Save 
As.

Setting the Identification Values

The application uses the Identification page parameters for the following:

• Generating a chromatogram from raw data

• Identifying the component peaks in the chromatogram

For more information about this page, see “Identification Page – User Identification Settings 
Dialog Box” on page 130.



 4 Working with Peak Identification and Detection
Using the User Identification Settings Dialog Box

Thermo Scientific Xcalibur Quan Browser User Guide 39

 To set identification parameters

1. In the User Identification Settings dialog box, click the Identification tab.

The Identification page opens (Figure 17).

Figure 17. Identification page – User Identification Settings dialog box

2. Select the type of trace and optional trace math operation stored in the processing method 
in the adjacent Plot Type lists. Only certain combinations of trace types are possible. 

For information about valid trace types, see “Identification Page – User Identification 
Settings Dialog Box” on page 130.

3. To apply a different scan filter, select a new filter from the Scan Filter list, select a new 
filter from the Scan Filter list and edit it, or type a new scan filter command string in the 
box using the scan filter format. 

For information about scan filter formats, refer to the Xcalibur Qual Browser User Guide.

4. View or change the masses stored in the processing method. 

This display area changes to accommodate the type of data required. When a single mass 
range is required, a single edit box displays the current value. If two mass ranges are 
required (as in the case of a trace defined as a Mass Range ± Mass Range or Base Peak ± 
Mass Range), this box is replaced by two boxes (in the case of Base Peak ± Mass Range, 
this box is replaced by the BP and MR boxes). In the case of a TIC (no trace operator in 
use), analog, or digital traces, this box is blank.
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5. In the Keys box, view comments stored in the processing method. This is a read-only 
field.

6. Set the Retention Time parameters as follows:

• To change the minimum width that a peak is expected to have if valley detection is 
enabled, type a new width in the Expected box. 

• To change the time window or to enter a new time window, type the number of 
seconds in the Window box. 

• To change the current view width, type the desired time in the View Width box.

7. Select a detector type from the Type list of detectors. (You configured this list using the 
Instrument Configuration dialog box.) 

8. Select an algorithm from the Peak Detection Algorithm list and click OK. 

The data system recalculates the current data using the specified algorithm. The 
application changes the default parameters for peak detection to parameters specific to 
that algorithm.

9. Do one of the following:

• Click Apply to apply the changes to the selected sample and component in the results 
grid.

–or–

• Click Apply to All to apply the current peak detection parameters to all samples that 
are currently displayed in the results grid of the Quan Browser window.

Setting the Detection Parameters

The application uses the parameters on the Detection page (see Figure 18) to confirm the 
identity of the component within the retention time window defined by the Identification 
settings. The options available on this page depend on whether the data is GC/MS data or 
LC/MS data.

For more information about this page, see “Detection Page – User Identification Settings” on 
page 134.
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 To set the detection parameters

1. In the User Identification Settings dialog box, click the Detection tab.

Figure 18 shows the Detection page for LC/MS data processed with the ICIS or Genesis 
algorithm.

Figure 18. Detection page – User Identification Settings dialog box

2. Make changes as appropriate.

3. Do one of the following:

• Click Apply to apply the changes to the selected sample and component in the results 
grid.

–or–

• Click Apply to All to apply the current peak detection parameters to all samples that 
are currently displayed in the results grid of the Quan Browser window.

Setting the Integration Parameters

The Xcalibur data system applies the settings on the Integration page (see Figure 19) during 
peak integration.

For more information about this page, see “Integration Page – User Identification Settings 
Dialog Box” on page 139.

Note  For information about the parameters on the Detection page for GC/MS data 
or for the Avalon algorithm, see “Detection Page – User Identification Settings” on 
page 134.
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 To set the integration parameters

1. From the User Identification Settings dialog box, click the Algorithm Integration tab.

Figure 19 shows the ICIS Integration page.

Figure 19. ICIS Integration page – User Identification Settings dialog box

2. Make changes as appropriate.

3. Do one of the following:

• Click Apply to apply the changes to the selected sample and component in the results 
grid.

–or–

• Click Apply to All to apply the current peak detection parameters to all samples that 
are currently displayed in the results grid of the Quan Browser window.

Note  For information about the parameters on the Detection page for the ICIS, 
Avalon, and Genesis algorithms, see “Detection Page – User Identification Settings” 
on page 134.



 4 Working with Peak Identification and Detection
Using the User Identification Settings Dialog Box

Thermo Scientific Xcalibur Quan Browser User Guide 43

Setting the Advanced Parameters for the Genesis and ICIS Algorithms

The Xcalibur data system applies the Advanced page parameters (see Figure 20) during peak 
detection and integration.

For information about the parameters on the Genesis Advanced page or the ICIS advanced 
page, see “Advanced Page – User Identification Settings Dialog Box” on page 145.

 To set the advanced parameters

1. From the User Identification Settings dialog box, click the Genesis Advanced or the ICIS 
Advanced tab.

Figure 20 shows the parameters on the ICIS Advanced page.

Figure 20. ICIS Advanced page – User Identification Settings dialog box
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2. To modify the settings on the ICIS Advanced page, do the following:

a. Do one of the following:

• Select the Manual Noise Region check box. The Noise Method area and the 
RMS check box become unavailable. When you select the Manual Noise Region 
check box, the data system automatically calculates the RMS noise of the selected 
retention time range. Go to step 2c.

–or–

• Select an option in the Noise Method area. The RT Range box becomes 
unavailable. Then, go to step 2b.

b. For the Incos or Repetitive Noise options, select the RMS check box to use the RMS 
noise calculation or clear the RMS check box to use the peak-to-peak noise 
calculation.

Go to step 2d.

c. To enter a retention time range for the Manual Noise Region, do one of the 
following:

• Type a retention time (RT) in the RT Range box.

–or–

• Click the Manual Noise Region icon, , in the toolbar and drag the cursor 
horizontally across the region of the chromatogram that you want to select as the 
noise region. The data system automatically fills the RT Range box with the 
retention time value.

Go to step 2d.

d. For all of the noise methods, do the following:

• In the Min Peak Width box, type a value from 0 to 100. This value defines the 
minimum number of scans required across the peak.

• In the Multiplet Resolution box, type a value from 1 to 500. This value defines 
the minimum number of scans between two peaks.

• In the Area Tail Extension box, type a value from 0 to 100. This value defines the 
number of scans past the peak endpoint to use in averaging the intensity.

• In the Area Scan Window box, type a value from 0 to 100. This value defines the 
number of scans on each side of the peak apex.
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3. Do one of the following:

• Click Apply to apply the changes to the selected sample and component in the results 
grid.

–or–

• Click Apply to All to apply the current peak detection parameters to all samples that 
are currently displayed in the results grid of the Quan Browser window.

Setting the Flags Values

For more information about the Flags page, see “Flags Page – User Identification Settings 
Dialog Box” on page 148.

 To use the Flags page

1. In the User Identification Settings dialog box (Figure 21), click the Flags tab.

Figure 21. Flags page – User Identification Settings dialog box

2. To test the validity of detected peaks, check the values on the Flags page.

3. Type a value in the current Area Threshold (AT) box. The data system sets the AT flag in 
the result file if the quantified peak has an area that is lower than the entered value. 

4. Type a value in the current Height Threshold (HT) box. The application sets the HT flag 
in the result file if the quantified peak has a height that is lower than the entered value. 
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5. Do one of the following:

• Click Apply to apply the changes to the selected sample and component in the results 
grid.

–or–

• Click Apply to All to apply the current peak detection parameters to all samples that 
are currently displayed in the results grid of the Quan Browser window.

Integrating Chromatogram Peaks Manually
In the Quan Browser window, you can manually change the starting and ending points of 
chromatographic peaks.

 To modify and test component peak integration criteria

1. To open the sequence file that contains the calibration standards, from the Quan Browser 
window, choose File > Open. 

The Open dialog box opens. 

2. In the Files of Type list, select Sequence List Files. Browse to find the correct file. Select 
it and click Open. 

The View Sample Types dialog box opens. 

3. To accept the All Sample Types default option, click OK.

The data system displays the results grid, component list, chromatogram plot, and 
spectrum plot or calibration curve views. 

4. To select a component, select the named component in the component list. The 
chromatogram of the component appears in the chromatogram plot view. 

Not Found chromatogram peaks do not have blue baselines.

Found chromatogram peaks have blue baselines.
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5. (Optional) Examine the chromatogram plot view as follows: 

• To replot the chromatogram with a different x axis, drag the cursor horizontally over 
the range that you want to expand. The application rescales the axis and replots the 
data with the new x-axis range. 

• To replot the chromatogram with a different y axis, drag the cursor vertically over the 
range that you want to expand. The application rescales the axis and replots the data 
with the new y-axis range. 

• To cancel the replot and return to the full range of the x axis and the highest peak 
normalized to 100.0 on the y axis, do one of the following:

– Click the Reset Scaling icon, . in the toolbar.

–or–

– Choose Zoom > Reset Scaling from the menu bar.

6. To change the status of a peak from Found to Not Found (optional), right-click the 
chromatogram plot view and choose Set Peak to Not Found Status from the shortcut 
menu. The data system removes the blue baseline to the component peak, reduces the 
Area to 0, and changes the Peak Status to Not Found.

7. To change the status of a peak from Not Found to Found [Added] (optional), do the 
following:

a. Right-click the chromatogram plot view and choose Manually Add Peak from the 
shortcut menu. 

A cursor with an arrow and a blue box appears.

b. Drag the pointer across the desired baseline, from peak start to peak end.

The data system adds a blue baseline to the component peak, integrates the peak, displays 
the Area in the results grid, and changes the Integration Type to Manual Integration. 
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8. (Optional) Edit the baseline integration criteria of a Found or Added peak as follows:

a. Click the left or right square editable handle on the blue baseline of the selected peak. 
The data system changes the cursor to a +:

b. Drag the handle to define a new location of the left or right peak limit. Repeat this 
procedure for the opposite side of the peak if required.

The data system automatically recalculates the results for the component and displays 
them in the results grid. If the sample is a standard, the data system replots the data and 
redraws the calibration curve in the calibration curve view.

Using the Spectrum Plot Companion View
The spectrum plot view displays a spectrum from the current chromatogram in the 
chromatogram view. View spectra from the apex, left peak edge, or right peak edge of a 
chromatographic peak by using commands from the shortcut menu. When the view is 
pinned, view scans from any part of the chromatogram by clicking the chromatogram. 
Initially, the data system displays the spectrum corresponding to the scan at the current 
chromatogram’s apex retention time. If no peak is detected, the application displays the 
expected retention time as defined by the processing method.

Use the spectrum plot view to examine the identity of peaks and other features (such as the 
background) in the chromatogram. 

For further analysis, including library matching of spectra, export data to Qual Browser using 
the Send to Qual Browser command in the shortcut menu for the results grid above the 
graphical views. 

For more information about the spectrum plot view, see “Quan Browser Spectrum Plot View” 
on page 90.

 To display the spectrum plot view

Do one of the following:

• Choose View > Set Companion View > Show Spectrum Plot.

–or–

• Right-click the companion view and choose Show Spectrum Plot from the shortcut 
menu.

 To display the spectrum for a specific time point in the current chromatogram

1. Make the Spectrum Plot view active by pinning the cell.

2. In the chromatogram view, click the time point of interest.
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 To use the shortcut menu commands

Right-click the spectrum plot view and choose one of these commands from the shortcut 
menu:

• To display the spectrum at the apex retention time of the current chromatogram, 
choose Spectrum at Peak Apex.

• To display the spectrum at the left edge retention time of the current integration 
baseline, choose Spectrum at Peak Left Edge.

• To display the spectrum at the right edge retention time of the current integration 
baseline, choose Spectrum at Peak Right Edge.

• To change the companion view to display the calibration curve, choose Show 
Calibration Curve.

• To display the full spectrum in a normalized window, choose Reset Scaling.

 To rescale the plot 

Use the cursor to select an area to magnify or use the Zoom menu commands and icons 
in the toolbar.
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Reviewing Spectrum Search Results for GC/MS Data
The Xcalibur data system only performs ion spectrum searches on GC/MS data. 

For information about setting up the spectrum search settings in the processing method, refer 
to the Xcalibur Data Acquisition and Processing User Guide.

 To review the results of a spectrum search in Quan Browser

1. From the Quan Browser window, choose File > Open. The Open dialog box opens.

2. From the Files of Type list, select either SLD, RST, or XQN. Browse to find the file you 
want to review. Select it and click Open. The View Sample Types dialog box opens. 

3. Select the Show All sample types option, and click OK.

4. To select a component to review, click a component in the component list that has had a 
spectrum search as specified in the Processing Setup method. The application displays the 
chromatogram in the chromatogram plot view. 

5. To view the plot, right-click the chromatogram plot view to display the shortcut menu. 

Depending upon the spectrum search results, the data system displays 0, 1, 2, or 3 
candidates in the Chromatogram Plot shortcut menu. Candidates are ranked in the order 
of spectrum fit as 1, 2, or 3. 

This shortcut menu shows a spectrum search result that found two matching candidates. 
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6. Choose a spectrum search option:

• Show Peak Info: (Not Found): The data system did not find any peaks or could not 
find a spectrum match.

• Show Peak Info: The data system found a spectrum match and this was the best 
spectrum match—Candidate 1.

• Show Peak Info - Candidate 2: The data system found a spectrum match and this 
was the second best spectrum match.

• Show Peak Info - Candidate 3: The data system found a spectrum match and this 
was the third best spectrum match.

7. To review main component Candidate 1 results, choose the Show Peak Info command 
(the first of the two choices) from the Chromatogram Plot shortcut menu.

The Xcalibur system opens the Peak Information dialog box with the following title:

Peak Information – Component– Spectrum Candidate

and with the following pages: 

Info, More Info, Flags, More Flags, Suitability, and Spectrum

Review the read-only results. 

8. To review the other spectrum search results, choose the Show Peak Info - Candidate N 
command from the Chromatogram Plot shortcut menu.

The Xcalibur system opens the Peak Information dialog box with the following title:

Peak Information – Component – Spectrum Candidate

This dialog box displays the following pages: 

Info, Chro, and Spectrum 

The Chro page displays a total ion current plot of the Spectrum Candidate. The view is 
centered around the mass of interest and has the width used by the component peak 
display. 

Review the read-only results. Repeat this step for other candidates of interest.

9. To close the Peak Information dialog box, click Close.
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5

Working with the Calibration Settings

When you first open a sequence in the Quan Browser window, the Xcalibur data system 
performs peak detection, calibration, and quantitation according to the settings in the 
associated processing method.

Within the Quan Browser application, you can change the settings on the Curve, Isotope%, 
and Flags pages of the Calibration Settings dialog box. In addition, you can exclude one or 
more calibration points and one or more calibration levels from the from the calibration curve 
for each component.

Reviewing and Reworking the Calibration Settings in Quan Browser
Use the Calibration Settings dialog box in the Quan Browser window to review and rework 
the calibration settings for the target components and the amounts for the internal standard 
components. You can use the Curve, Isotope%, and Flags pages of this dialog box to test the 
effect of changing the calibration curve settings, the isotope% correction values, and the 
threshold flags.

Use the calibration curve plot, the results grid, or the Exclusion List dialog box to exclude data 
points for calibration standards from the calibration curve.

Note  In the Quan Browser window, you cannot change the component type (target or 
internal standard) or the internal standard component associated with a target compound. 
To change these calibration settings, you must modify the processing method in the Quan 
view of the Processing Setup window, and then batch reprocess the sample sequence in the 
Sequence Setup view. For information about creating processing methods and batch 
processing a sequence, refer to the Xcalibur Data Acquisition and Processing Guide.
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 To modify the calibration settings for a target component

1. Open a sequence in the Quan Browser window.

2. In the component list, select a target component. 

The application automatically updates the results grid, and the chromatogram and 
companion views.

3. To display only calibration standards in the results grid, click the Standards tab. 

4. If the calibration curve view is not displayed in the companion view, display it by doing 
one of the following:

• Choose View > Set Companion View > Show Calibration Curve.

• Right-click the chromatogram view and choose Set Companion View > Show 
Calibration Curve from the shortcut menu.

5. Inspect the calibration curve for the target component according to the criteria used in 
your laboratory. The calibration curve view displays the calibration equation, the 
goodness of fit parameter, R2, and the weighting, W. 

6. To adjust the calibration settings, do the following:

a. Right-click the calibration curve view and choose Calibration Settings from the 
shortcut menu. 

The Calibration Settings dialog box opens (Figure 22). For information about the 
pages of the Calibration Settings dialog box, see “Calibration Settings Dialog Box” on 
page 98.

Figure 22. Calibration Settings dialog box
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b. Do the following:

• To view the component type and the internal standard component associated 
with a target component, click the Type tab.

• To adjust the calibration equation, weighting, or units, click the Curve tab and 
make new selections and entries on the Curve page as described in “Reviewing 
and Reworking the Calibration Curve Settings” on page 55.

• To view the calibration or QC levels, click the Levels tab. For more information, 
refer to the Xcalibur Data Acquisitions and Processing User Guide.

• To make corrections for isotope contributions to ISTD or Target components, 
click the Isotope% tab and type new values in the boxes as described in 
“Changing the Isotope Percentage Values” on page 57.

• To change calibration and quantitation flag thresholds, click the Flags tab and 
type new values in the threshold boxes. For more information, refer to the 
Xcalibur Data Acquisitions and Processing User Guide.

c. To apply any changes to the sequence, click Apply.

7. To exclude data points from the calibration curve, follow the instructions in “Excluding 
Data Points from the Calibration Curve” on page 59.

8. To export the calibration settings with peak integration and detection parameters as a new 
processing method, choose File > Export Method.

Reviewing and Reworking the Calibration Curve Settings
Use the Curve page (see Figure 23) of the Calibration Settings dialog box to change the way 
the data system calculates and plots the calibration curve from the calibration standard data 
points. 

For more information about the Curve page, see “Curve Page – Calibration Settings Dialog 
Box” on page 98.

 To test the effect of changing the calibration curve settings for a target component

1. In the Quan Browser window, open a sequence and select the target component that you 
want to modify in the component list.

2. Open the Curve page of the Calibration Settings dialog box as follows:

a. Display the calibration curve view in the companion view by choosing View > Set 
Companion View > Show Calibration Curve. 

b. Right-click the calibration curve and choose Calibration Settings from the shortcut 
menu.
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c. Click the Curve tab. 

The Curve page opens (Figure 23).

Figure 23. Curve page – Calibration Settings dialog box

3. In the Calibration Curve list, select a calibration curve type: 

• If you select Linear or Quadratic, the Origin and Weighting options are available. 
Go to step 4. 

• If you select Point-to-Point or Cubic Spline, the Weighting options are not 
available. Go to step 5.

• If you select Linear Log-Log, Quadratic Log-Log, Average RF, or Locally 
Weighted, the Origin and Weighting options are not available. Go to step 6.

4. To apply weighting to the calibration points (for the Linear or Quadratic calibration 
curve type), select one of these options: Equal, 1/X, 1/X^2, 1/Y, 1/Y^2, or 1/s^2. This 
selection makes sure the data system applies the correct regression weighting method 
when it calculates the least-squares regression calibration curve. 

5. Select how to treat the origin in the calibration curve calculation (for the Linear, 
Quadratic, Point-to-Point, or Cubic Spline curve type): 

• To not include the origin in the calibration curve calculation, select the Ignore 
option.

• To require that the calibration curve passes through the origin, select the Force 
option.

• To include the origin as one data point, select the Include option.
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6. To select the units to be displayed on graphs and reports, type the required units label in 
the Units box.

7. Select how the data system determines the response: 

• To determine the response based on the integrated area of component peaks, select 
the Area option.

• To determine the response based on the calculated height of component peaks, select 
the Height option. 

8. To apply the new settings, click Apply.

The data system updates the values in the results grid and replots the calibration curve in 
the calibration curve plot view.

9. To save the new settings and close the dialog box, click OK.

These parameters are identical to those in the Target Compounds area on the Calibration 
page of Quan view in Processing Setup. These are described in more detail in “Calibration 
Settings Dialog Box” on page 98.

Changing the Isotope Percentage Values
Use the Isotope% page (see Figure 24) of the Calibration Settings dialog box to correct data in 
these situations:

• An impurity in the internal standard compound that elutes at the same time as the target 
compound

• An impurity in the target compound that elutes at the same time as the internal standard

These parameters are identical to those in the Correction For Isotope Contribution dialog 
box, accessed from the Calibration page of Quan view in Processing Setup. 

 To set the Isotope% parameters 

1. In the Quan Browser window, select the component of interest in the component list. 
Then, choose View > Set Companion View > Show Calibration Curve to display the 
calibration curve for the component.

2. Right-click the companion view and choose Calibration Settings from the shortcut 
menu. 

The Calibration Settings dialog box opens.

3. Click the Isotope% tab. 

The Isotope page opens (Figure 24).
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Figure 24. Isotope% page – Calibration Settings dialog box

4. Specify the correction values as follows:

• If you have an impurity in your internal standard that elutes at the same time as the 
target molecule, use the ISTD to Target Compound box to type a value for the ratio 
ISTD[impurity]/ISTD[pure], as a percentage (ratio × 100). 

To determine this ratio experimentally, analyze the ISTD reagent using the method 
to be used for quantitation of the target compound. Use the respective peak areas or 
heights to determine the ratio of the impurity that elutes at the same time as the 
target compound to the pure internal standard compound that elutes at a different 
retention time.

• If you have an impurity in your target compound (TM) reagent that elutes at the 
same time as the ISTD compound, use the Target Compound to ISTD box to type a 
value for the ratio TM[impurity]/TM[pure], as a percentage (ratio × 100). 

To determine this ratio experimentally, analyze the target compound reagent using 
the method to be used for quantitation of the target compound. Use the respective 
peak areas or heights to determine the ratio of the impurity that elutes at the same 
time as the ISTD compound to the pure target compound that elutes at a different 
retention time.

The data system corrects for the impurities in the ISTD reagent, the target 
compound reagent, or both using the data you provide in this step, and reports the 
corrected amounts of ISTD and TM.

5. Click Apply to apply the new settings.

The data system updates the values in the results grid and replots the calibration curve.

6. To save the settings and close the dialog box, click OK.
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Excluding Data Points from the Calibration Curve
In the Quan Browser window, you can include or exclude data points from the calibration 
curve in three ways:

• Click a data point in the calibration curve view and choose Include or Exclude from the 
shortcut menu. 

• Select or clear the check boxes in the Exclude column of the results grid.

• Open the Cal Exclusion list dialog box and select the data points to be excluded or 
included.

 To examine the calibration curve for a target component

1. In the Quan Browser window, open the sequence of result files with the calibration curve 
or curves that you want to modify as follows:

a. Choose File > Open. 

The Open dialog box opens. 

b. In the Files of type list, select (.sld). Browse to find the correct file. Select it and click 
Open. 

The View Sample Types dialog box opens. 

c. Select the Show All sample types option and click OK.

The results grid, component list, chromatogram plot, and either the spectrum plot or 
calibration curve view open. 

2. In the component list, select the component of interest. 

The calibration curve for the selected component appears in the calibration curve view. 

Note  When you include or exclude calibration standards that are shared between 
brackets, their status is unique to the bracket. For example, excluding a shared calibration 
standard in bracket 1 has no effect on its inclusion status in bracket 2. 

The results grid does not display the calibration points from an external calibration file 
(XCAL).

IMPORTANT  When you close Quan Browser, the data system erases your selections. Save 
your selections by choosing File > Save As to create a Quan Browser file (XQN). 
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3. Examine the calibration curve data: 

• To replot the data with a different x axis, drag the cursor horizontally over the range 
that you want to expand. The application rescales the axis and replots the data with 
the new x-axis range. 

• To replot the data with a different y axis, drag the cursor vertically over the range that 
you want to expand. The application rescales the axis and replots the data with the 
new y-axis range. 

• To cancel the replot and return to the full range for both axes, click . 

 To directly include or exclude data points in the calibration curve plot view

1. In the component list, select the target component of interest.

The calibration curve view displays the calibration curve for the selected component.

2. In the calibration curve view, right-click the point that you want to exclude and choose 
Exclude from the shortcut menu (Figure 25).

Figure 25. Selecting the Exclude command from the shortcut menu

The following occur:

• The data system recalculates the calibration curve.

• In the corresponding row of the results grid, the word “Excluded” appears in the Peak 
Status column and the check box is selected in the Exclude column. 

• In the Cal Exclusion List dialog box, the word “Yes” appears in the Exclude column.

• In the calibration curve view, the excluded data point appears as an unfilled box 
(Figure 26).
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Figure 26. Excluded data point appears as an unfilled box

3. To exclude an entire calibration level, exclude all of the replicate data points for the level.

4. To restore the excluded data point to the calibration curve, right-click the unfilled box 
and choose Include.

The following occur:

• The data system recalculates the calibration curve.

• In the corresponding row of the results grid, no text appears in the Peak Status 
column and the check box is cleared in the Exclude column. 

• In the Cal Exclusion List dialog box, no text appears in the Exclude column.

• In the calibration curve view, the restored data point appears as a filled box.

 To include or exclude data points by using the results grid

• To exclude a data point from the calibration curve, select its respective check box in 
the Exclude column of the results grid.

• To restore the data point to the calibration curve, clear its respective check box in the 
Exclude column of the results grid.

IMPORTANT  If the calibration information includes data points from an external 
calibration file (XCAL), the results grid does not include these data points. The results 
grid only includes the data points in the current sequence bracket.
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 To use the Cal Exclusion List dialog box to include or exclude calibration data points

1. In the component list, select the target component of interest.

2. Right-click the calibration curve view and choose Exclusion List from the shortcut 
menu. 

The Cal Exclusion List dialog box opens (Figure 27). The Cal Exclusion List dialog box 
includes all the data points in the calibration curve, including the data points from an 
external calibration file (if used).

Figure 27. Cal Exclusion List dialog box

The dialog box lists all the replicates used in the current bracket or group and their 
exclusion status. The dialog box contains the following columns: 

Level Shows the name for the level.

Expected Displays the expected amount for the level.

%Diff Shows the percentage difference between the measured and 
expected amounts.

Exclude Denotes excluded levels by the word Yes.
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3. To exclude data points and recalculate the calibration curve, do the following:

a. Click the Exclude column adjacent to the data points to be excluded. 

b. Click Apply.

The data system does the following:

• Recalculates the calibration curve without the excluded data points.

• Updates the corresponding Peak Status and Exclude fields in the results grid to 
show that the data points are excluded.

• Redraws excluded data points as unfilled squares.

4. To restore excluded data points and recalculate the calibration curve, do the following:

a. Click the Exclude column adjacent to the data points to be restored (on the word 
Yes). 

b. Click Apply.

The data system does the following:

• Incorporates the data points in the calibration and recalculates the curve.

• Updates corresponding Peak Status and Exclude fields in the results grid to show 
that the points are now included.

• Redraws the included data points as filled squares.

5. To close the dialog box, click OK.
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6

Viewing Results and Generating Reports

Follow these procedures to review the quantitative results and generate reports.

Reviewing the Results of the Quantitative Analysis
 To review and rework results before you print reports

1. Open the Quan Browser window (see “Starting Quan Browser” on page 15).

The Open dialog box opens so that you can select a file to review and rework. You can 
select a sequence list file (SLD), a result file (RST), or a Quan Browser file (XQN).

2. Select the file and click OK. 

The View Sample Types dialog box opens. 

3. Select either the Show Standard and QC Sample Types or Show All Sample Types 
option. Click OK.

The Quan Browser window opens with the results grid, component list, chromatogram 
plot view, and calibration curve or spectrum plot view.

4. In the component list, select the target component that you want to review.

5. To display calibration standards results, click the Standards tab.

6. Inspect the calibration curve in the calibration curve view. Evaluate the calibration curve 
according to the criteria used in your laboratory. 

• You can right-click the calibration curve view to display commands in the shortcut 
menu for modifying the information in this view. 

• You can right-click a data point in the calibration curve view to display commands in 
the shortcut menu for modifying the data in this view. 
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7. To select the first data file, click the first row in the results grid.

8. Check the entries in the results grid for peak detection and integration problems. Ensure 
that the selected data file corresponds to the correct level and sample type. 

You can right-click the results grid to display commands in the shortcut menu for 
modifying the information in the results grid.

9. Change the information in any of the following columns by clicking the appropriate grid 
cell:

• In the Sample Type column, click a cell and select Standard, QC, Blank, or 
Unknown from the list.

• In the Integration Type column, click a cell and select Method Settings, User 
Settings, or Manual Integration from the list.

• In the Levels column, click a cell and select another defined level from the list.

• In the Exclude column, select or clear the Exclude check box in a cell to exclude or 
include the sample in the bracket calibration. Selecting the check box excludes the 
data and is indicated in the grid by Yes.

When a sample is shared between two brackets, you cannot change its sample type. The 
data system notifies you when a sample is part of two overlapping brackets if you attempt 
to change its Integration Type, Level, or Exclude state.

10. Inspect the component peak in the chromatogram plot view: 

• Make sure that the data system found the peak. The data system shades all found 
peaks gray and marks the starting and ending points with square integration markers. 

• Make sure that the data system integrated the peak properly. The shaded area should 
accurately represent the contribution of the component to the chromatogram. 

For more information about identifying, detecting, and integrating peaks, see Chapter 4, 
“Working with Peak Identification and Detection.” 

If necessary, perform steps 11 and 12.

11. To modify the peak detection and integration settings (optional), do the following: 

a. Right-click the chromatogram plot view to display commands in the shortcut menu 
for modifying the information in this view. 

b. Choose User Peak Detection Settings to display the User Identification Settings 
dialog box. For more information, see “Using the User Identification Settings Dialog 
Box” on page 37. 
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c. Do one or more of the following:

• To modify the peak detection settings, click the Detection tab.

• If you have problems with noise in the peak or peak tailing, click the Integration 
tab to modify the settings.

• If baseline noise is interfering with peak identification or integration, click the 
Advanced tab to modify the settings.

12. To manually change the starting and ending points and baseline of the peak, drag the 
square integration markers to the desired location.

13. To review the next data file, click the next row in the results grid. Go to step 8.

14. To review and rework the QC results, do the following:

a. Click the QCs tab.

b. Perform steps 7 through 13 for the QCs. Evaluate the QCs according to the criteria 
used in your laboratory.

15. To review and rework the Blank results, do the following:

a. Click the Blanks tab.

b. Perform steps 7 through 13 for the blanks. Evaluate the blanks according to the 
criteria used in your laboratory.

16. To review and rework the Unknown results, do the following:

a. Click the Unknowns tab.

b. Perform steps 7 through 13 for the Unknowns. Evaluate the Unknowns according to 
the criteria used in your laboratory.

17. For each remaining component, select the component in the component list, and then 
perform steps 8 through 15.
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Generating Reports
To generate reports in the Quan Browser window, follow these procedures:

• To open the Reports dialog box

• To select the samples to be included in the reports

• To set up the sample and summary reports

• To print or save the selected reports

 To open the Reports dialog box

In the Quan Browser window, do one of the following:

• Click the Reports Dialog icon, , in the toolbar. 

–or–

• Choose View > Reports Dialog from the menu bar.

The Reports dialog box (Figure 28) duplicates the Reports view in Processing Setup. 
When opened, it displays the reports specified in the processing method associated with 
the active sequence. The displayed parameters might change as you select different 
brackets.

Figure 28. Reports dialog box in the Quan Browser window
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 To select the samples to be included in the reports

1. Click Select Samples.

The Select Report Samples dialog box opens. The Sample Choices box on the left lists the 
all of the samples in the current sequence bracket (Figure 29).

Figure 29. Select Report Samples dialog box

2. Select the samples that you want to include in the reports:

• To select a range of samples, hold the SHIFT key down. Then, click Add to copy the 
selected samples to the Selected Samples box.

• To select multiple samples, hold the CTRL key down. Then, click Add to copy the 
selected samples to the Selected Samples box.

–or–

• To include all of the samples in the reports, click Add All.

3. Click OK to close the dialog box and accept the sample list.

The Reports dialog box lists the number of samples selected.
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 To set up the sample and summary reports

1. In the Sample Reports area, do the following for each sample report template that you 
want to use:

a. Double-click the Report Template Name table cell to open the Open Template 
dialog box. Then, browse to the location of your report templates, select a report 
template, and click Open.

The default location of the XReport templates is as follows:

drive:\Xcalibur\templates

b. Select the check box in the Enabled column to make the sample type columns 
available.

When you click another table cell, the check box is replaced with the text Yes and by 
default all of the sample types are selected.

c. Click the table cell for each sample type that you want to remove from the report. 
and clear the check box.

The check box disappears leaving the table cell empty.

d. In the Save As column, select one of the following;

• Select None if want to send the document directly to the printer.

–or–

• Select one of the available file types to save the report to the folder where your 
result files reside. 

Figure 30 shows the selection of one sample report template for all of the selected 
samples. With the selection of None in the Save As column, the data system sends the 
reports directly to the printer.

Figure 30. Sample Reports area
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2. In the Summary Reports area, do the following for each summary report that you want to 
use:

• Select the check box in the Enabled column.

• Double-click the Report Template Name table cell to open the Open Template 
dialog box. Then, browse to the location of your report templates, select a report 
template, and click Open.

3. At the bottom of the Reports dialog box, select the following:

• To print or save the selected sample reports, select the Include Sample Reports 
check box.

• To print or save the selected summary reports, select the Include Summary Reports 
check box.

 To print or save the selected reports

At the bottom of the Reports dialog box, click Print Reports. 

Prior to printing reports, the data system does the following:

• Displays the Printer Activity icon at the bottom of the Quan Browser window. 

• Combines the data in the sample files you selected with the report templates you 
selected. 

• Displays the XReport Saving Report dialog box if you chose a file type (Text, Doc, 
HTML, PDF, RTF, or XLS) for the reports. 

• Adds the report printing task to the processing queue if you chose None as the file 
type in the Save As column, and then displays the Printing message box. 

The data system returns you to the Quan Browser window after it saves the reports to the 
folder where the result files reside or the reports print. The default file name format is as 
follows: RawFileNameReportTemplateName.

Note  If you do not select at least one of these check boxes, Quan Browser displays the 
following message when you click Print Reports:

No report types selected for printing.
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A

Quan Browser Window

Use the Quan Browser window to review sequence results for each component in each file. 
You can quickly review component peak identification and integration criteria. If you make 
any changes, you can save the new results with an audit trail describing the reason for the 
change.

Use Quan Browser to interactively edit processing parameters and audit changes for 
individual result files. It also creates new result files that contain the processing results for 
individual raw files. These result files include a copy of the method used to generate the 
results. 

Result files changed using Quan Browser do not affect the original processing method. To edit 
processing methods, refer to the Xcalibur Acquisition and Processing User Guide.

Contents

• Quan Browser Window

• Quan Browser Dialog Boxes



A Quan Browser Window
Quan Browser Window

74 Xcalibur Quan Browser User Guide Thermo Scientific

Quan Browser Window
The Quan Browser window consists of a title bar, toolbar, menu bar, and status bar. The 
workspace area contains the results grid, component list, chromatogram view, and companion 
view. The chromatogram plot view is always displayed in the lower left portion of the window. 
You can display the spectrum plot view or the calibration curve view in the companion view.

For more information about the elements of the Quan Browser window, see these topics:

• “Quan Browser Title Bar” on page 75

• “Quan Browser Menu Bar” on page 76

• “Quan Browser Toolbar” on page 81

• “Quan Browser Results Grid” on page 84

• “Quan Browser Component List” on page 88

• “Quan Browser Chromatogram Plot View” on page 88

• “Quan Browser Spectrum Plot View” on page 90

• “Quan Browser Calibration Curve View” on page 92

This table provides brief descriptions of the workspace areas in the Quan Browser window.

Table 1. Quan Browser workspace (Sheet 1 of 2)

Area Use

Results grid View the sample rows that are retrieved from the sequence or 
result file. You can right-click this view to display a shortcut 
menu. Use this menu to review and edit the results grid.

Component list View a list of all of the components contained in the current 
bracket. This list is in the order of user data entry in the processing 
method. Found/Not Found symbols are placed to the left of the 
component names depending on whether the Xcalibur data 
system found the component based on the current detection 
criteria for the component.

Chromatogram plot 
view

View the currently selected component chromatogram from the 
currently selected result file. This view, located in the lower left 
corner of the Quan Browser window, displays a plot of relative 
abundance versus time in minutes for the selected component. 
You can right-click this view to display a shortcut menu to review 
and change peak detection and integration settings.
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Quan Browser Title Bar

The title bar, located in a horizontal band at the extreme top of the window, contains the 
following:

• Application name

• Current process

• Current file name

• Any optional parameters that are relevant

For example, if the active result file is ABC.sld, the data system might display: 

Quan Browser - Browser - ABC.sld [Bracket 1, View All].

Companion View

Located to the right of the chromatogram plot view (its companion) in the lower right 
corner of the Quan Browser window. In the companion view you can choose either the 
spectrum plot view or the calibration curve view.

Spectrum plot view View a plot of relative abundance (y axis) versus mass-to-charge 
ratio for the selected component. You can right-click this view to 
display a shortcut menu to display the spectrum at the left edge, 
apex, and right edge of the chromatogram peak. Also, you can 
reset the scaling of the view.

Calibration curve view View a plot of area or area ratio (y axis) versus concentration or 
amount (x axis) for the selected component. You can right-click 
this view to display a shortcut menu to review and change 
calibration settings, reset the scaling of the view, and copy the 
graph. If you right-click a calibration point, the Calibration Point 
shortcut menu appears so that you can exclude/include the point, 
review calibration settings, reset the scaling of the view, or copy 
the graph.

Table 1. Quan Browser workspace (Sheet 2 of 2)

Area Use
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Quan Browser Menu Bar

The Quan Browser menu bar provides access to these menus:

• File Menu – Quan Browser

• View Menu – Quan Browser

• Zoom Menu – Quan Browser

• Options Menu – Quan Browser

• GoTo Menu – Quan Browser

• Help Menu – Quan Browser

File Menu – Quan Browser

This table describes the File menu commands for the Quan Browser window.

Table 2. File menu commands (Sheet 1 of 2)

Command Description

Open Open new data files. The supported file types are 
sequence (SLD), result (RST), and Quan Browser (XQN) 
files. 

Save Create a new Xcalibur Quan Browser file with an (.xqn) 
extension. This file contains all the necessary information 
required to recreate the current browser session.

Save As Create a new Xcalibur Quan Browser file with an (.xqn) 
extension. This file contains all the necessary information 
required to recreate the current browser session. 

Save All Update all result files with the current information. Each 
result file comes from a results row in the results grid. 
Since each row can use method, user, or manual 
integration and the result file can contain only one 
method, the currently selected method for that row is 
used when creating the result file. The embedded 
processing method is flagged as modified. This means 
that each result file can potentially contain different 
embedded processing methods. If read back into Quan 
Browser, the first sample’s embedded processing method 
is used for the method settings of the entire bracket. 
When read in, each sample that has a modified processing 
method is set in the User integration mode, and it is up to 
the operator to reintegrate and quantitate using a 
common method if desired.
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Export Method Export the processing method of the currently selected 
row. If no processing method is available, the data system 
uses the original processing method. 

Export Data To Excel

Short Report Create a short Excel report. The short report displays the 
data contained in the current bracket and contains the 
same information that is available in each results grid row. 

Long Report Create a long Excel report. The data system reports on the 
data contained in the current bracket and contains the 
same information that is available in each results grid row, 
as well as other information that is not displayed in the 
grid. 

Summary Information View summary information for the current XQN file. 

Change Dataset Name Select a dataset from a predefined list of names. 

The text of this menu item might be different if the 
administrator chooses to use another name for a dataset. 
For example, this menu item might be Change Job Name. 

Audit Trail View all auditable events and changes made to data files 
in the current application. 

Print Setup Select a printer, paper, and page orientation. 

Print

Reports Dialog Select and turn Report Templates on and off along with 
other options for sample reports and summary reports. 

All Enabled Reports Print all active and currently selected sample reports as 
well as all active summary reports. 

Enable Sample Reports Print active and currently selected sample reports. 

Enable Summary Reports Print all active summary reports. 

Recently Used Files View the paths and names of the most recently used files, 
located above the Exit command. The data system 
displays both open and closed files. Click a displayed file 
to load it. If the selected file is closed, the application 
reopens it. 

Exit Close the Quan Browser window. This option does not 
close any other Xcalibur windows. The Home Page 
window is not closed. 

Table 2. File menu commands (Sheet 2 of 2)

Command Description
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View Menu – Quan Browser

This table describes the View menu commands for the Quan Browser window.

Table 3. View menu commands

Command Description

Set Companion View

Show Calibration Curve View the calibration curve view in the lower right corner 
of the Quan Browser window. 

Show Spectrum Plot View the spectrum plot view in the lower right corner of 
the Quan Browser window.

Reports Dialog Specify the report template name to be used for sample 
reports or summary reports.

Toolbar View or hide the toolbar. The toolbar appears if it was 
previously hidden or hides if it is currently displayed. 

Status Bar View or hide the status bar. The status bar appears if it 
was previously hidden or hides if it is currently displayed.

Show Large Toolbar View either the large or small Quan Browser toolbar. The 
large toolbar is displayed when a check mark appears to 
the left of the command. The small toolbar is displayed 
when the check mark to the left of the Show Large 
Toolbar command is cleared.

Customize Toolbar Drag any toolbar icon from this dialog box to any 
location on the Quan Browser toolbar and from the 
toolbar to this dialog box.
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Zoom Menu – Quan Browser

This table describes the Zoom menu commands for the Quan Browser window.

Options Menu – Quan Browser

This table describes the Options menu commands for the Quan Browser window.

Table 4. Zoom menu commands

Command Description

Zoom In Y To show more detail, zoom in on the y axis by a factor of two (2) 
from the current baseline. 

Zoom Out Y To show more data, zoom out on the y axis by a factor of two (2). 

Auto Range View the chromatogram, which is normalized from the minimum 
to the maximum signal. (This zoom feature is recommended for 
PDA and UV data.)

Normalize Normalize the intensity scale of the data display to a fixed range on 
the y axis, for example, from 0–25% to 0–100%.

Zoom In X To show more detail, zoom in on the x axis by a factor of two (2).

Zoom Out X To show more detail, zoom out on the x axis by a factor of two (2) 
from the center.

Display All View all data on the x axis or all text in a report. 

Reset Scaling To display the maximum amount of data, reset the scaling of both 
the x and y axis.

Table 5. Options menu commands

Command Description

Delete ComponentName Delete the currently selected component from analysis. 
This command results in a recalibration. 

Masses View or change the default settings for mass tolerance and 
mass precision.

View Stds And QCs/ View All View either all components or just standards and quality 
control samples in the results grid.

Enable Warnings View, as needed, all warnings boxes, even though their 
display has been previously suppressed.
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GoTo Menu – Quan Browser

This table describes the Go To menu commands for the Quan Browser window.

Help Menu – Quan Browser

This table describes the Help menu commands for the Quan Browser window.

Table 6. Go To menu commands

Command Description

Instrument Setup Open the Instrument Setup window. 

Processing Setup Open the Processing Setup window.

Qual Browser Open the Qual Browser window.

Library Browser Open the Library Browser window.

Xcalibur Home Page Open the Home Page window.

Table 7. Help menu commands

Command Description

Quan Browser Help Open Xcalibur Help and view Help for the Quan 
Browser window.

Xcalibur Help Open Xcalibur Help.

Glossary Open the glossary. 

How To Use Help Open Help that describes how to use the Help viewer.

About Quan Browser Open the About Quan Browser dialog box. This dialog 
box displays the installed version number of the Quan 
Browser program and the Thermo Fisher Scientific 
copyright notice. 

Tip  You can access the manuals, as PDF files, from the Home Page – Roadmap view.

In the Home Page – Roadmap view, choose Help > Manuals to open a shortcut menu 
with links to the Xcalibur manual set.
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Quan Browser Toolbar

When you install the Xcalibur data system, the Quan Browser toolbar displays these buttons.

To add or remove buttons, use the Customize Toolbar dialog box. For information about 
using the Customize Toolbar dialog box, see the Customize Toolbars topic in the data system 
Help.

This table describes the buttons and icons, by category, that can appear on the Quan Browser 
toolbar. 

Table 8. Quan Browser toolbar buttons (Sheet 1 of 4)

Button Description

File

Open Open previously saved data files. The Xcalibur data system supports these 
file types: sequence (SLD), result (RST), and Quan Browser (XQN) files. 

Save When a previously saved Quan Browser file is open, clicking Save saves the 
recent changes to the file. When you start a new Quan Browser session, 
clicking Save opens the Save As dialog box, where you can save the session 
as a new Quan Browser file with an (.xqn) extension. This file contains all 
the necessary information required to re-create the current browser session.

Save As Opens the Save As dialog box, where you can specify a name and directory 
location for the Quan Browser file (XQN) that contains all the necessary 
information required to re-create the current browser session.

Save All Update all result files with the current information. Each result file comes 
from a results row in the results grid. Since each row can use method, user, 
or manual integration, and the result file can contain only one method, the 
Xcalibur data system uses the currently selected method for that row when 
creating the result file. The system flags the embedded processing method 
as modified. This means that each result file can potentially contain 
different embedded processing methods. 

When you reopen the sequence in Quan Browser, the system uses the first 
sample’s embedded processing method for the entire bracket’s method 
settings. If a sample has been processed with a modified processing 
method, the Integration Type column of the result table displays the User 
Integration selection. The operator must reintegrate and quantitate using a 
common method.

Reports Dialog Select and turn Report Templates on or off along with other options for 
sample reports and summary reports.

Print All Enabled Reports Print all active and currently selected sample reports as well as all active 
summary reports. 
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Print Enabled Sample Reports Print active and currently selected sample reports. 

Print Enabled Summary 
Reports

Print all active summary reports. 

View

Show Calibration Curve View the calibration curve view in the lower right corner of the Quan 
Browser window. 

Show Spectrum Plot View the spectrum plot view in the lower right corner of the Quan Browser 
window. 

Reports Dialog Select and enable previously created report templates and other options for 
sample reports and summary reports. 

Show Large Toolbar View either the large or small Quan Browser toolbar. The Xcalibur data 
system displays the large toolbar when you select the check box to the left 
of the command. The system displays the small toolbar when you clear the 
check mark to the left of the Show Large Toolbar command.

Zoom

Zoom In Y To show more detail, zoom in on the y axis by a factor of two (2) from the 
current baseline. 

Zoom Out Y To show more data, zoom out on the y axis by a factor of two (2). 

Auto Range View the chromatogram, which is normalized from the minimum to the 
maximum signal. (This zoom feature is recommended for PDA and UV 
data.)

Normalize Normalize the intensity scale of the data display to a fixed range on the 
Y-axis, for example, from 0–25% to 0–100%.

Zoom In X To show more detail, zoom in on the x axis by a factor of two (2).

Zoom Out X To show more detail, zoom out on the x axis by a factor of two (2) from the 
center.

Display All View all data on the x axis or all text in a report. 

Reset Scaling To Full Scale To display the maximum amount of data, reset the scaling of both the 
x and y axis.

Table 8. Quan Browser toolbar buttons (Sheet 2 of 4)

Button Description
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Noise

Manual Noise Region Specify a noise region manually. 

 To select a manual noise region

Click the Manual Noise Region icon, , and drag the cursor 
horizontally across the region of interest in the chromatogram.

The data system marks the region with a red baseline and updates 
noise value in the Signal to Noise box on the Info page of the Peak 
Information dialog.

The application calculates noise based on the data points you select. It uses 
all selected data points as noise points and calculates noise based on those 
points. You can select the noise region from an individual trace or different 
noise regions from multiple traces.

To make this button active, open a raw file and select a chromatogram. 

Delete Manual Noise Region Remove a designated manual noise region. 

 To remove a manual noise region

1. Click the Delete Manual Noise Region icon, , and drag the 
cursor over the region that was previously selected as the noise region. 

2. Release the mouse button to delete the noise region. 

Options

View Stds And QCs View all components or just standards and quality control samples in the 
results grid.

GoTo

Instrument Setup Open the Instrument Setup window. 

Processing Setup Open the Processing Setup window. 

Qual Browser Open the Qual Browser window. 

Library Browser Open the Library Browser window. 

Xcalibur Home Page Open the Home Page window if it is closed or display the Home Page 
window if it is already open. This command closes the Instrument Setup 
window so that all instrument setup methods are closed when samples that 
use these methods are run from the Home Page window. 

Table 8. Quan Browser toolbar buttons (Sheet 3 of 4)

Button Description
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Quan Browser Results Grid

The results grid (Figure 31) displays sequence or result sample data entries. Each row defines a 
result file and its associated parameters. Selecting any cell within the results grid causes the 
additional views to refresh, using data from the newly selected sequence row. The Xcalibur 
data system validates any changes made to the sequence row and updates the chromatogram 
plot, calibration curve, and spectrum plot views automatically.

Figure 31. Results grid

In the Options menu, if you choose to view to View Stds and QCs, the results grid displays 
three tabs: All, Stds, and QCs. The All page displays all Stds and QCs, the Stds page displays 
only standards, and the QCs page displays only QCs.

In the Options menu, if the viewing preference is set to View All, the results grid displays five 
tabs: All, Stds, QCs, Blanks, Unknowns. The All page in this case displays all Stds, QCs, 
Blanks and Unknowns. The Stds page displays only standards, the QCs page displays only 
QCs, the Blanks page displays only blanks, and the Unknowns page displays only unknowns.

Depending on the current settings of the Result List Column Hiding dialog box, the results 
grid can display different parameters for each sample row.

These topics describe the columns in the results grid view and the shortcut menu:

• Results Grid Columns

• Results Grid Shortcut Menu

Help

Quan Browser Help View Help for Quan Browser. Opens the Xcalibur Help system to the 
Quan Browser section.

Table 8. Quan Browser toolbar buttons (Sheet 4 of 4)

Button Description
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Results Grid Columns

This table describes the columns in the results grid of the Quan Browser window.

Table 9. Results grid parameters (Sheet 1 of 2)

Column Description

File Name
(read-only) 

View the raw file that contains the acquisition data for this run. 

Sample Type View or change the sample type that has been assigned to the 
sample. Every sample must be designated one of these four basic 
types: Standard, QC, Blank, or Unknown. 

You cannot change sample type of a sample that is shared between 
two brackets. If you try to make this type of change, the data 
system displays a warning message:

You cannot change the sample type of a sample shared 
between brackets. Reverting back to original sample type.

Integration Type View or change the method the used to integrate the peak. 

The selections are Method Settings, User Integration, and Manual 
Integration. 

• Select Method Settings to apply the integration parameters 
defined during the processing setup phase. 

• Select User Integration to override the integration parameters 
within Quan Browser. 

• Select Manual Integration when the integration baseline was 
selected by dragging the baseline handles. 

Area Or Height
(read-only)

View the integrated area (count-seconds) or height (counts) under 
the detected peak. 

Internal Standard 
(ISTD) Area/Height
(read-only)

View the integrated area (count-seconds) or height (counts) under 
the detected Internal Standard peak. 

Area Ratio or Height 
Ratio
(read-only)

View the area or height ratio between the selected peak and the 
Internal Standard peak. 

Specified Amount
(read-only)

View the amount of the component at the Cal or QC level. 

Calculated Amount
(read-only)

View the component amount, as determined by the response ratio 
and calibration curve. 

% Difference
(read-only)

View the percentage difference between the calculated amount 
and the specified amount. 
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% Relative Standard 
Deviation
(read-only)

View the standard deviation of the difference between the 
calculated amount and the specified amount, as expressed as a 
percentage of the specified value.

Peak Status
(read-only)

View the peak status:

Low: if the %Difference is < 0

High: if the %Difference is > 0

Fail: if the %Difference is > the QC fail percentage test value

Level View or change the calibration or QC level of the sample. 

To change this value, click the grid cell and select another level 
from the list. 

Units
(read-only)

View the units used for quantity or concentration. 

Retention Time
(read-only)

View the retention time in minutes at the peak maximum. 

Sample ID
(read-only)

View the unique sample identification string. 

Exclude Indicate whether to include or exclude the sample point from the 
calibration curve. Include or exclude a data point by clicking the 
grid cell; select the check box to include the data point or clear it 
to exclude the data point. 

Table 9. Results grid parameters (Sheet 2 of 2)

Column Description
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Results Grid Shortcut Menu

This table describes the menu commands in the shortcut menu for the results grid in the 
Quan Browser window.

Table 10. Results grid shortcut commands

Command Description

Column Open the Result List Column Hiding dialog box, where you can 
modify the columns that appear in the results grid. 

For more information, see “Result List Column Hiding Dialog 
Box” on page 126.

Delete Selected 
Samples

Remove the currently selected samples from the results grid view. 
If you delete standard samples, the data system recalibrates the 
data. If you delete either standard samples (stds) or quality control 
samples (QCs), the application recalibrates the (%) Relative 
Standard Deviation.

Add Sample Select a new file from a browse dialog box. The data system adds it 
to the results grid view and sorts it according to the sort order. If 
you add standard samples, the application recalibrates the data. If 
you add either standard samples (stds) or quality control samples 
(QCs), the Xcalibur system recalibrates the (%) Relative Standard 
Deviation.

Copy Row Duplicate the currently selected row and add it to the next row of 
the results grid view. If the row added is a standard sample (std), 
then a recalibration takes place. If it is either a standard sample 
(std) or a quality control sample (QC), then the data system 
recalculates the (%) Relative Standard Deviation.

Set Sorting Order Set the sort order for the samples in the results grid view.

Send To Qual Browser Open the result file for the sample that you selected in Qual 
Browser. 
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Quan Browser Component List

The component list on the right side of the window lists the components in the processing 
method associated with the currently loaded sequence. To select a component of interest, 
select the component name from the list. All Quan Browser views are automatically updated 
to reflect the settings and data for the selected component. The component list provides the 
only method of selecting a component of interest.

Figure 32. Component list for the drugx example set

Quan Browser Chromatogram Plot View

The chromatogram plot view is the graphical display pane in the lower left portion of the 
Quan Browser window.

This table describes the shortcut menu commands for the chromatogram plot view.

Table 11. Chromatogram plot view shortcut commands (Sheet 1 of 2)

Command Description

Method Settings Reset the integration method to those specified in the original 
method stored within the result file.

User Settings Apply a set of user-defined peak detection parameters to the 
integration of this peak. See “Using the User Identification 
Settings Dialog Box” on page 37 for more information.

Manual Integration If active, this command indicates that the integration baseline has 
been adjusted by dragging the control boxes on the plot. This 
command is inactive until you adjust the baseline by using the 
graphical dragging operation at least once.

Show Peak Info View peak information in a read-only format. The information 
displayed reflects the settings for the currently displayed 
chromatographic peak. Select other compounds or other result 
files to get detailed information on the found peak. To close the 
dialog box, click Close. 

The compound identification name is displayed in the title bar. 
For example:

Peak Information – drugx
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User Peak Detection 
Settings

Apply unique peak detection parameters to the chromatogram. 
The tabbed pages on this dialog box differ for GC and LC 
processing methods. These differences are described in the 
appropriate sections. The type of processing used to create the 
result file comes from the processing method (also stored within 
the result file) and are not available for changes within Quan 
Browser.

Display Options Place labels, such as retention time, scan number, base peak, 
signal-to-noise, flags, area, and height, on your chromatograms.

This menu command is not active if no chromatogram data is 
displayed in the chromatogram plot view. 

Manually Add Peak Manually place a baseline on the Chromatogram Plot and set the 
current integration method for the current component to Manual 
Integration. The Xcalibur data system changes the entry in the 
Integration Type box of the results grid view.

If no peak has been detected for the currently selected compound, 
there is no integration baseline on the chromatogram plot for you 
to manually adjust. 

Set Peak To Not Found 
Status

Tag the current peak as Not Found, do another peak search 
(possibly with new integration parameters), or do a manual 
integration to restore the peak.

Update Expected 
Retention Time

Update the retention time specified in the processing method with 
the retention time that the Xcalibur data system detected. 

Update Component In Current Row: This command updates 
the retention time of the current component in the current row of 
the active sequence and recalculates the data for the row in the 
results grid view.

Update All Components In Current Row: This command 
updates the retention time of all the components in the current 
row of the active sequence and recalculates the data for the row in 
the results grid view.

Reset Scaling This command resets the plot scale to include the full peak in a 
normalized window.

Table 11. Chromatogram plot view shortcut commands (Sheet 2 of 2)

Command Description



A Quan Browser Window
Quan Browser Window

90 Xcalibur Quan Browser User Guide Thermo Scientific

Quan Browser Spectrum Plot View

When you select the spectrum plot view (Figure 33) located in the lower right corner of the 
Quan Browser window as the companion plot, the spectrum plot view displays a spectrum 
from the peak apex of the current chromatogram. 

Figure 33. Spectrum plot view with shortcut menu displayed

To display the spectrum plot view in the companion view, do one of the following:

• In the toolbar, click the Show Spectrum Plot icon, .

–or–

• From the menu bar, choose Set Companion View > Show Spectrum Plot. 
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You can select a spectrum from a different time point in the chromatogram in two ways:

• Pin the spectrum plot view, and then click a time point in the chromatogram.

• Right-click the spectrum plot view and select Spectrum At Peak Left Edge or Spectrum 
At Right Edge from the shortcut menu.

This table describes the shortcut menu commands for the spectrum plot view. For more 
information about working with the spectrum plot view, see “Using the Spectrum Plot 
Companion View” on page 48.

Table 12. Spectrum plot view shortcut commands

Command Description

Spectrum At Peak Apex View the spectrum at the apex retention time of the 
displayed chromatogram peak.

Spectrum At Peak Left Edge View the spectrum of the left edge of the displayed 
chromatogram peak. The left edge is defined at the 
retention time corresponding to the left baseline box 
(handle).

Spectrum At Peak Right Edge View the spectrum of the right edge of the displayed 
chromatogram peak. The right edge is defined at the 
retention time corresponding to the right baseline box 
(handle).

Display Options Select the style, color, labels, axis, and normalization 
options for your spectrum from the Display Options 
dialog box. 

This menu command is not active if no spectrum data is 
displayed in the spectrum plot view. 

Show Calibration Curve View the calibration curve view in the lower right corner 
of the Quan Browser window. 

Reset Scaling Reset the plot scale to include the full peak in a 
normalized window.
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Quan Browser Calibration Curve View

To display the calibration curve view in the companion view, do one of the following:

• In the toolbar, click the Show Calibration Curve Plot icon, .

–or–

• From the menu bar, choose View > Set Companion View > Show Calibration Curve. 

Right-click in the calibration curve view (except on a calibration point) to display the shortcut 
menu for the view. 

Right-click a calibration point on the calibration curve in the calibration curve view to display 
the following shortcut menu.
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This table describes the shortcut menu commands for the calibration curve view.

Table 13. Calibration curve view shortcut commands

Command Description

Exclude If the data point is currently included in the calibration, selecting 
the Exclude command forces the calibration curve to be 
recalculated without the selected data point. The excluded entry 
in the results grid view is updated to show that this point is 
excluded and the excluded data point is redrawn on the calibration 
curve using an unfilled square.

Include If the current data point was previously excluded, the first menu 
item is Include. Select this command to include the data point 
and recalculate the calibration curve. The data system updates the 
excluded entry in the results grid to show that this point is now 
included and redraws the included data point on the calibration 
curve using a filled square.

Note  You can include or exclude samples that are shared 
between brackets. Sample status is unique to the bracket—that 
is, excluding a shared sample in bracket 1 has no effect on its 
inclusion status in bracket 2.

Calibration Settings Select values for the following parameters: type, curve, levels, 
isotope%, and flags. These options appear when you display a 
valid calibration curve.

Save Calibration File Name and save the calibration file to the directory of your choice. 

Exclusion List Open the Exclusion List dialog box and select points in the 
calibration curve to include or exclude. 

Show Spectrum Plot View the spectrum plot view in the lower right corner of the Quan 
Browser window. 

Reset Scaling Reset the plot scale to include the full peak in a normalized 
window.

Copy Graph Copy the calibration curve view to the clipboard so that you can 
transfer it to another open application, such as Microsoft Word, 
using the Paste command. This operation is useful when you are 
writing a report and want to include the calibration curve.
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Quan Browser Dialog Boxes
The Quan Browser window has the following dialog boxes: 

• “Add Sample Dialog Box” on page 95

• “Bracket/Group In Use List” on page 96

• “Cal Exclusion List Dialog Box” on page 97

• “Calibration Settings Dialog Box” on page 98

• “Display Options Dialog Box in Quan Browser” on page 107

• “Masses Dialog Box” on page 107

• “Peak Information Dialog Box” on page 108

• “Quantitation Results Sorting Order Dialog Box” on page 119

• “Reports Dialog Box” on page 121

• “Result List Column Hiding Dialog Box” on page 126

• “Select Level Dialog Box” on page 127

• “Select Report Samples Dialog Box” on page 128

• “User Identification Settings Dialog Box” on page 129

• “View Sample Types Dialog Box” on page 149
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Add Sample Dialog Box

Use the Add Sample dialog box to change information about the sample or samples that you 
are adding to the results grid in the Quan Browser window.

For information about adding samples to the results grid and changing the settings in the 
result files for the parameters listed below, see “Adding and Removing Samples” on page 28.

This table describes the parameters in the Add Sample dialog box.

Table 14. Add Sample dialog box parameters

Parameter Description

Sample Type Select a sample type for a new sample. 

Level Select a level for a new sample.

Sample ID Enter the sample ID for a new sample. 

Sample Name Enter the sample name for a new sample. 

ISTD Corr Amt Enter the ISTD amount for a new sample. 

Dilution Factor Enter the dilution factor for a new sample. 

Use Sample Name and 
Comment from 
Selected RawFile(s)

To edit the Sample Name and Comments fields, clear this check 
box.

To use the Sample Name and Comment embedded in the raw file, 
select this check box.

Comment Enter a comment about the new sample.
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Bracket/Group In Use List

Use this list to select the current bracket or group being browsed. Select a new bracket or 
group from the list to refill the results grid view with the samples from the selected bracket. 
The Xcalibur data system updates all additional plots and dialog boxes automatically.

This table describes the Bracket/Group In Use list that is located above the results grid of the 
Quan Browser window.

Table 15. Bracket/Group In Use list parameters

Parameter Description

Bracket in use If a bracketed sequence is open, the Bracket in use list is active and 
displays the available brackets numbered sequentially from one to 
the number of brackets in the sequence, for example: Bracket 1, 
Bracket 2, Bracket 3, and so on. If the sequence contains multiple 
brackets, the data system selects the first bracket in the list and 
displays the samples related to that bracket in the results grid view. 
If the sequence contains only one bracket, then the list displays 
only one entry: Bracket 1.

Group in use If an unbracketed sequence is open, the Group in use list is active 
and displays groups broken up logically. For example: Group 1, 
Group 2, Group 3, and so on. Groups are separated by standards 
and are created using the following rules: 

The data system scans the sequence file in chronological order 
until the first standard (either Std Clear or Std Update) is 
encountered. The first standard begins a new group. The 
application continues looking through the sequence, adding all 
samples to this group until the next standard after the first 
nonstandard is found. There are two deviations from this rule. 
The first exception is that the first group does not have to start 
with a standard. The first sample, by definition, begins the first 
group. The second exception is that any Std Clear begins another 
group even if it immediately follows a Std Update.
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Cal Exclusion List Dialog Box

In the Quan Browser window, you can exclude a data point from the calibration curve in three 
ways. You can right-click a data point in the calibration curve view and select Exclude from 
the shortcut menu. You can select the appropriate check box in the Exclude column of the 
results grid. Or, you can use the Cal Exclusion List dialog box. For more information about 
excluding data points from the calibration curve, see “Excluding Data Points from the 
Calibration Curve” on page 59.

The Cal Exclusion List dialog box displays a list of all the data points used in creating the 
current calibration curve. When you use an external calibration file (.xcal) with an 
unbracketed sequence, the results grid does not include the data points from the external 
calibration file. The results grid only includes the data points from the current sequence 
bracket. The data points from the external calibration file are accessible in the Cal Exclusion 
List dialog box or the calibration curve plot.

The title bar of the Cal Exclusion List dialog box contains the name of the selected 
component:

Cal Exclusion List – ComponentName

The exclusion list displays all the replicates used in the current bracket or group and their 
exclusion status. If there is a Yes in the exclude column, then the Xcalibur data system excludes 
this replicate data point in the calibration curve plot. If the column is blank, then the Xcalibur 
system includes the replicate in the calibration curve plot. To change the status of any 
replicate, click the exclude column in the row containing the replicate data point. This 
changes the value. Click Apply to make the changes, but keep the Exclusion List dialog box 
visible. Click OK to accept the changes and close the dialog box. Click Cancel to abandon the 
changes and close the dialog box.

This table describes the parameters in the Cal Exclusion List dialog box.

Table 16. Cal Exclusion List dialog box parameters

Parameter Description

Level View the read-only calibration level names for the sample data 
points displayed in the calibration curve view. 

Expected View the read-only expected quantity values for the data points 
displayed in the calibration curve view. 

% Diff View the read-only percent difference values for the data points 
displayed in the calibration curve view. These values are the 
percentage difference between the calculated amount and the 
expected amount. 

Exclude Click each row (replicate) in the Exclude column to turn Yes on 
and off. Yes indicates that the data point is excluded from the data 
points displayed in the calibration curve view. 
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Calibration Settings Dialog Box

The Xcalibur data system displays particular pages in the Calibration Settings dialog box, 
based on whether the component is an Internal Standard or a Target. For more information, 
see, “Reviewing and Reworking the Calibration Settings in Quan Browser” on page 53.

For an internal standard component, the following page is available:

• “Type Page – Calibration Settings Dialog Box” on page 105

For a target component, the following pages are available:

• “Curve Page – Calibration Settings Dialog Box” on page 98

• “Flags Page – Calibration Settings Dialog Box” on page 100

• “Isotope% Page – Calibration Settings Dialog Box” on page 101

• “Levels Page – Calibration Settings Dialog Box” on page 104

• “Type Page – Calibration Settings Dialog Box” on page 105

Curve Page – Calibration Settings Dialog Box 

Use the Curve page to modify component type settings that you specified on the Calibration 
page in the Quan view of the Processing Setup window. 

To test the results of the new setting, click Apply or OK. 

This table describes the parameters on the Curve page of the Calibration Settings dialog box.

Table 17. Curve page parameters – Calibration Settings dialog box (Sheet 1 of 2)

Parameter Description

Calibration Curve View or change the selected calibration curve type. 

Origin

Specify how to use the origin in your calibration curve. You can choose to ignore the origin 
as a data point, force the curve to pass through it, or include it as a single point on the 
calibration curve. 

Ignore Exclude the origin as a valid point in your calibration curve. If you 
select this option, the calibration curve might or might not pass 
through the origin. 

Force Specify that the calibration curve passes through the origin of the 
data point plot. 

Include Include the origin as a single data point in the calculation of the 
calibration curve. If you select this option, the calibration curve 
might or might not pass through the origin. 
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Response

Use the area or the height of the target compound peak to acquire the data used for the 
calibration.

Area Use the area of the target compound peak to acquire the data used 
for the calibration.

Height Use the height of the target compound peak to acquire the data 
used for the calibration.

Weighting

Equal Give all calibration data points equal weight during the 
least-squares regression calculation of the calibration curve. 

1/X Specify a weight value of 1/X for all calibration data points during 
the least-squares regression calculation of the calibration curve. 
The data system assigns a weight value of the inverse of their 
quantity.

1/X^2 Specify a weight value of 1/X^2 for all calibration data points 
during the least-squares regression calculation of the calibration 
curve. The data system assigns a weight value of the inverse of the 
square of their quantity.

1/Y Specify a weight value of 1/Y for all calibration data points during 
the least-squares regression calculation of the calibration curve. 
The data system assigns a weight value of the inverse of their 
response (or response ratio).

1/Y^2 Specify a weighting of 1/Y^2 for all calibration data points during 
the least-squares regression calculation of the calibration curve. 
The data system assigns a weight value of the inverse of the square 
of their response (or response ratio).

1/s^2 Specify a weighting of 1/s^2 for all calibration data points during 
the least-squares regression calculation of the calibration curve. 
Calibrants at a given level are weighted by the inverse of the 
standard deviation of their responses (or response ratios). For this 
weighting factor to be used, there must be two or more replicates 
at each level. If only one calibrant is available for any level, 1/s^2 
weighting cannot be used.

Units

View or change the units set on the Calibration page of the Quan 
view of Processing Setup. The units are also used in reports and in 
Quan Browser. 

Table 17. Curve page parameters – Calibration Settings dialog box (Sheet 2 of 2)

Parameter Description
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Flags Page – Calibration Settings Dialog Box

The Flags page of the Calibration Settings dialog box displays the current calibration and 
quantitation flags in use for the selected compound. The Xcalibur data system uses these 
values in determining if the calibration or quantitation is within user specified criteria. They 
do not alter the way calculations are made. An entered value of zero forces the flag to be false. 

During entry of the values in the Quantitation Flags box, the Xcalibur data system checks to 
make sure that the relationships between the four fields are maintained. If an entry in one 
field forces a change to occur in another field, the Automatic Adjustment message box is 
displayed with the following message:

The last change made has forced an automatic change in one or more of the remaining 
edit boxes. This is due to the fact that each value and the acceptable ranges for that value 
are linked.

This table describes the parameters on the Flags page of the Calibration Settings dialog box.

Table 18. Flags page parameters – Calibration Settings dialog box

Parameter Description

Calibration Flag

R-Squared View or change the current value of R-squared. The data system 
sets the R-Squared (RS) flag in the result file if the computed 
coefficient of determination is lower than the entered R-Squared 
value. 

Quantitation Flags

Limit Of Detection View or change the current value for the limit of detection. The 
data system sets the Limit of Detection (LOD) flag in the result 
file if the peak concentration is less than the entered Limit of 
Detection. 

Limit Of Quantitation View or change the current value for the limit of quantitation. 
The data system sets the Limit of Quantitation (LOQ) flag in the 
result file if the peak concentration is less than the entered Limit 
of Quantitation. 

Linearity Limit View or change the current value for the linearity limit. The data 
system sets the Limit of Linearity (LL) Flag in the result file if the 
peak concentration is greater than the entered Linearity Limit. 
Linearity Limit + 10 percent is the calibration curve's x-axis upper 
value (default) when displayed in the Quan Browser window. The 
user can then go on to change this x-axis range. 

Carry Over Limit View or change the current value for the carryover limit. The data 
system sets the Carry Over Limit (COL) flag in the result file if 
the peak concentration is greater than the entered Carry Over 
Limit. 
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Isotope% Page – Calibration Settings Dialog Box 

Use the Isotope (%) page of the Calibration Settings dialog box to correct for one or both of 
the following:

• An impurity in the internal standard compound that elutes at the same time as the target 
compound

• An impurity in the target compound that elutes at the same time as the internal standard 
compound

 To determine the percent impurity in the internal standard reagent

Analyze the ISTD reagent using the method to be used for quantitation of the target 
compound. Use the respective peak areas or heights to determine the ratio of impurity to 
pure compound.

 To change the percent impurity for the internal standard reagent, 

Type a new value in the Contribution of ISTD to Target Compound box, as a percentage 
(ratio × 100%).

The valid range is 0.00 to 100.00 percent. 

 To determine the percent impurity in the target compound reagent

Analyze the Target reagent using the method to be used for its quantitation. Use the 
respective peak areas or heights to determine the ratio of impurity to pure compound. 

The valid range is 0.00 to 100.00 percent. 

 To change the percent impurity for the target compound reagent

Type a new value in the Contribution of Target Compound to Internal Standard box, as a 
percentage (ratio × 100%). 

The valid range is 0.00 to 100.00 percent.
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This table describes the parameters on the Isotope (%) page of the Calibration Settings dialog 
box.

 

Table 19. Isotope (%) page parameters – Calibration Settings dialog box (Sheet 1 of 2)

Parameter Description

Contribution of

ISTD To Target 
Compound (%)

Specifies the percent impurity in the internal standard reagent:

Where:

ISTD [impurity] is an impurity compound in the internal standard reagent that elutes 
at the same time as the target compound. 

ISTD [pure] is the pure internal standard compound. 

The valid range is 0.00 to 100.00 percent. 

The data system uses this percentage (converted to a ratio) as the value for x in the following 
impurity correction expressions:

ISTD [corr] = [ISTD [obs] – y Target [obs]]/[1 – yx]

Target [corr] = [Target [obs] –  x ISTD [obs]]/[1 – yx]

Where:

ISTD [corr] is the corrected amount of the internal standard compound. 

ISTD [obs] is the apparent amount of the internal standard compound, as measured by 
the application at the retention time for the internal standard compound. This peak 
consists of ISTD [corr] + Target [impurity]. 

Target [corr] is the corrected amount of the target compound. 

Target [obs] is the apparent amount of the target compound, as measured by the 
application at the retention time for the target compound. This amount consists of 
Target [corr] + ISTD [impurity]. 

See the parameter description “Target Compound To ISTD” on page 103 for a complete 
description of variable y.

Percent impurity in ISTD reagent ISTD [impurity]
ISTD [pure]

--------------------------------- 100=
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Contribution of

Target Compound To 
ISTD

Specifies the percent impurity in the target compound: 

Where:

Target [impurity] is an impurity compound in the target compound reagent that elutes 
at the same time as the internal standard. 

Target [pure] is the pure target compound. 

The data system uses this percentage (converted to a ratio) as the value for y in the following 
impurity correction expressions:

ISTD [corr] = [ISTD [obs] – y Target [obs]]/[1 – yx]

Target [corr] = [Target [obs] – x ISTD [obs]]/[1 – yx]

Where:

ISTD [corr] is the corrected amount of the internal standard compound. 

ISTD [obs] is the apparent amount of the internal standard compound, as measured by 
the data system at the retention time for the pure internal standard compound, 
ISTD [pure]. This peak consists of ISTD [corr] + Target [impurity]. 

Target [corr] is the corrected amount of the target compound. 

Target [obs] is the apparent amount of the target compound, as measured by the data 
system at the retention time for the pure target compound, Target [pure]. This amount 
consists of Target [corr] + ISTD [impurity]. 

See the parameter description “ISTD To Target Compound (%)” on page 102 for a 
complete description of variable x.

Table 19. Isotope (%) page parameters – Calibration Settings dialog box (Sheet 2 of 2)

Parameter Description

Percent impurity in Target reagent Target [impurity]
Target [pure]

------------------------------------- 100=
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Levels Page – Calibration Settings Dialog Box 

Use the Levels page of the Calibration Settings dialog box to review the current component 
type settings that you specified in the processing method. These are read-only boxes.

Table 20. Levels page parameters – Calibration Settings dialog box

Parameter Description

Cal Level View the calibration levels for the selected component.

Amount View the amount of target compound used for each calibration 
level.

QC Level/ 
Amount/%Test Table 
settings

View QC (quality control) level names, quality control level 
amounts, and %test values. QC samples containing known 
amounts of a component can be utilized to help ensure the 
accuracy of an analysis. The data system measures the quantity of 
the QC component in the same manner as unknown components 
and compares the measured quantity with a user-defined expected 
quantity and a user-defined percent test.

QC Level View the quality control levels for the selected component. The 
application can accommodate up to 15 QC levels. 

Amount View the quantity used for each QC level, as defined by the user. 

% Test View a value for the acceptable difference (as a percent) between 
the known amount and the calculated (measured) amount of each 
QC level. 

Units View the units set on the Calibration page of the Quan view in 
Processing Setup. The application also uses the units in reports 
and in Quan Browser. 
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Type Page – Calibration Settings Dialog Box 

The parameters on the Type page of the Calibration Settings dialog box changes depending 
on whether the selected component is an internal standard component or a target component.

For an internal standard component, use the Type page to change the Amount and Units 
settings that you specified on the Calibration page in the Quan view of the Processing Setup 
window.

For an analysis that contains more than one internal standard component, use the Type page 
to associate a different internal standard component with the selected target component.

This table describes the parameters for an internal standard component on the Type page of 
the Calibration Settings dialog box.

Table 21. Internal Standard component parameters

Parameter Description

Component Type

The data system recognizes two component types for component calibration purposes: 
Target Compound components and Internal Standards (ISTD) components. You can 
initially define, select, and characterize components of interest using the Calibration page in 
the Quan view of the Processing Setup window. 

In the Quan Browser window, you can change the amount of the internal standard 
component and the display units. The options in the Component Type area are unavailable. 

Target Compound For an internal standard component, this option is not selected.

ISTD For an internal standard component, this option is selected. 

Internal Standard (ISTD)

Amount Specifies the amount of the selected internal standard component 
that is added to each sample. 

To change the amount, type amounts with up to three decimals of 
precision in the Amount box. 

Units Specifies the units used for the internal standard amount or 
concentration, for example, ng or pg/mL. You can change the 
units.
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This table describes the parameters for target component on the Type page of the Calibration 
Settings dialog box.

Table 22. Target component parameters

Parameter Description

Component Type

The data system recognizes two component types for component calibration purposes: 
Target Compound components and Internal Standards (ISTD) components. Components 
of interest are initially defined, selected, and characterized using the Calibration page in the 
Quan view of the Processing Setup window. These parameters can then be revised using the 
Type page of the Calibration Settings dialog box available in the Quan Browser window.

Target Compound For a target component, this option is selected. 

ISTD For a target component, this option is not selected. 

The ISTD option is unavailable if you processed the data with an 
external standard calibration.

ISTD This list contains all the internal standard components defined in 
the processing method.

If the processing method contained more than one internal 
standard component, you can select a different internal standard 
component for the selected target component from the list.
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Display Options Dialog Box in Quan Browser

In the Quan Browser window, use the pages of the Display Options dialog box to select Style, 
Color, Labels, Axis, and Normalization settings. The parameters on these pages depend on 
whether the view in the active cell is a chromatogram or a spectrum.

For information about the parameters on these pages, refer to the Xcalibur Qualitative Analysis 
User Guide or the Xcalibur Help.

Masses Dialog Box

Use this dialog box to specify tolerance and precision settings for the mass data displayed in 
the chromatogram, spectrum, map, and ion map plots. 

Specify the default values for tolerance and precision on the Mass Options page of the 
Xcalibur Configuration dialog box. 

This table describes the parameters in the Masses dialog box.

•

Note  The parameters on the Style, Color, Labels, Axis, and Normalization pages of the 
Dialog Options dialog box depend on whether the view in the active cell is a 
chromatogram or a spectrum. The same pages for the chromatogram and spectrum views 
are available from the real-time display view and the Qual Browser, Quan Browser, and 
Processing Setup windows.

Table 23. Masses dialog box parameters

Parameter Description

Mass tolerance

Mass tolerance Specify the value for mass tolerance. Type a value in the range of 
0.1 to 50 000 and select units to apply to the value. The Xcalibur 
data system uses the tolerance value to create the mass range limit. 

Units Specify the units of measurement in which the data system 
processes your data. Select mmu (millimass units) or ppm (parts 
per million). 

Mass precision

Decimals Specify the number of decimal places (mass precision) that the 
data system uses to display mass values. You can specify from 0 to 
5 decimal places. The number of decimal places applies to the 
mass data in a window. 
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Peak Information Dialog Box

The Peak Information dialog box provides read-only information about the currently 
displayed chromatogram peak (for GC/MS or LC/MS data) or one of the peaks used by the 
spectrum search or ion ratio confirmation routines (for GC/MS data). You can use this dialog 
box to quickly get detailed information on the found peak by selecting other components or 
other result files. 

The current component name is displayed in the title bar, for example: 

Peak Information – drugx

Depending on the peak type, the Peak Information dialog box displays one or more of these 
pages:

• “No Peak Page – Peak Information Dialog Box” on page 109

• “Info Page – Peak Information Dialog Box” on page 110

• “Flags Page – Peak Information Dialog Box” on page 111

• “More Flags Page – Peak Information Dialog Box” on page 114

• “Chro Page – Peak Information Dialog Box” on page 115

• “Info or More Info Page – Peak Information Dialog Box” on page 116

• “Spectrum Page – Peak Information Dialog Box” on page 118

• “Suitability Page – Peak Information Dialog Box” on page 118

For more information about reviewing the information in the Peak Information dialog box, 
see “Viewing Peak Information” on page 35.

Table 24 describes the possible peak types. Table 25 lists the pages displayed in the Peak 
Information dialog box for each peak type.

Table 24. Peak types for the Peak Information dialog box (Sheet 1 of 2)

Peak type Description

No peak If no peak has been found for the component, the 
Xcalibur data system displays only the No Peak page with 
the following message: 

No Peak Found. Cannot show Peak Info.

Standard peak (LC) A standard peak is a peak found in a system using a liquid 
chromatograph (LC) as the inlet, the title bar contains the 
following text:

Peak Information – component name
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No Peak Page – Peak Information Dialog Box

If the Xcalibur data system does not find a peak for the component, only the No Peak page is 
displayed with the following message: 

No Peak Found. Cannot show Peak Info.

Qualifier ion peak (GC) In a system using a gas chromatograph (GC) as the inlet, 
if the peak is for a Qualifier Ion, the title bar contains the 
following text:

Peak Information – component name – Qual Ion Mass 
xxx.x, where xxx.x represents the mass of the qualifier 
ion

Spectrum candidate peak (GC)
(First candidate)

In a system using a gas chromatograph (GC) as the inlet, 
if the peak is for the first spectrum candidate, the title bar 
contains the following text: 

Peak Information – component name – spectrum 
candidate, where spectrum candidate is the first 
candidate

Spectrum Candidate Peak (GC)
(Second and Third Candidate)

In a system using a gas chromatograph (GC) as the inlet, 
if the peak is for the first spectrum candidate, the title bar 
contains the following text: 

Peak Information – component name – spectrum 
candidate, where the spectrum candidate is the 
second or third candidate

Table 24. Peak types for the Peak Information dialog box (Sheet 2 of 2)

Peak type Description

Table 25. Peak Information dialog pages based on the peak type

Peak Type Info Flags More Flags Suitability Spectrum More Info Chro

No peak –*

* (–) This page is not displayed.

– – – – – –

Standard peak (LC) X**

** (X) This page is displayed.

X X X X – –

Qualifier ion peak (GC) X X X X X X X

Spectrum candidate peak (GC)
(First candidate)

X X X X X X –

Spectrum Candidate Peak (GC)
(Second and Third Candidate)

– – – – X X X



A Quan Browser Window
Quan Browser Dialog Boxes

110 Xcalibur Quan Browser User Guide Thermo Scientific

Info Page – Peak Information Dialog Box

Use the Info page of the Peak Information dialog box to review the following peak properties 
for the current component.

This table describes the parameters on the Info page of the Peak Information dialog box.

Table 26. Info page parameters – Peak Information dialog box

Parameter Description

Left (min) Displays the left extreme of the integration baseline for the current 
component in minutes (read-only). 

Apex (min) Displays the apex point in minutes of the integration baseline for 
the current component (read-only). 

Right (min) Displays the right extreme of the integration baseline for the 
current component in minutes (read-only). 

Height Displays the height of the current component peak apex in units 
of counts (read-only). 

Area (cts-sec) Displays the area of the current component peak in units of 
count-seconds (read-only). 

Baseline Displays the baseline height directly below the apex of the current 
component peak in units of counts (read-only).

Base Peak (m/z) Displays the mass-to-charge ratio of the ion with the largest 
response in the current component peak (read-only). 

Signal To Noise Displays the measured signal-to-noise ratio at the apex of the 
current component peak. (read-only)

Expected RT (min) Displays the expected retention time of the current component 
(read-only). 

ISTD Response Displays the integrated area in units of count-minutes or the 
height of the apex in units of counts for the current component 
peak (read-only). 

Response Ratio Displays the ratio of the peak sample peak area or height to the 
internal standard area or height (read-only). 

Calculated Amount Displays the amount of sample calculated by the Xcalibur data 
system using the response ratio and the calibration curve 
(read-only). 
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Flags Page – Peak Information Dialog Box

Use the Flags page of the Peak Information dialog box to review the following peak properties 
for the current component.

This table describes the parameters on the Flags page of the Peak Information dialog box.

Table 27. Flags page parameters – Peak Information dialog box (Sheet 1 of 4)

Parameter Description

Integration info

Detected By Displays the method that the data system used to detect the peak:

Spectrum: The application uses the user-defined mass/intensity 
pairs and applies a spectral-matching algorithm to find the peak 
that contains the closest match to the comparison spectrum. Up to 
50 entries are allowed to define the comparison spectrum.

Highest Peak: The application searches for the highest peak 
within the search window.

Nearest RT: The application searches for the peak nearest to the 
expected retention time.

Left Edge Type Displays how the data system detected the left baseline edge of the 
current peak. The data system displays one of the following peak 
baseline detection methods:

Edge Type Reported by Xcalibur: Peak Criteria Met

Baseline (B): The edge of the peak is at baseline level.

Valley (V): The edge of the peak is in a peak valley.

Manual (M): The edge of the peak has been adjusted manually.

Stripe (S): The edge of the peak reached the Constrain Peak 
Height Percent specified in the method.

Tail (T): The edge of the peak reached the Constrain Peak Height 
Trailing Factor limit before the Height Percent.

Tilt (-): An error occurred before the data system could determine 
the edge of the peak.

Unknown (?): An unknown error occurred.
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View the edge type on many reports using a one-letter 
abbreviation for the left edge type and a one-letter abbreviation for 
the right edge type, as follows: 

Peak ID Left Edge Right Edge

BB Baseline Baseline

BT Baseline Tail

-B Tilt Baseline

SS Stripe Stripe

Valid Displays whether the data system successfully detected the peak 
indicated by selecting the Valid check box. 

Right Edge Type Displays how the data system detected the right baseline edge of 
the current peak. The application displays one of the following 
peak baseline detection methods:

Edge Type Reported by Xcalibur

Baseline (B): The edge of the peak is at baseline level.

Valley (V): The edge of the peak is in a peak valley.

Manual (M): The edge of the peak has been adjusted manually.

Stripe (S): The edge of the peak reached the Constrain Peak 
Height Percent specified in the method.

Tail (T): The edge of the peak reached the Constrain Peak Height 
Trailing Factor limit before the Height Percent.

Tilt (-): An error occurred before the edge of the peak could be 
determined.

Unknown (?): An unknown error occurred.

View the edge type on many reports using a one-letter 
abbreviation for the left edge type and a one-letter abbreviation for 
the right edge type, as follows: 

Peak ID Left Edge Right Edge

BB Baseline Baseline

BT Baseline Tail

-B Tilt Baseline

SS Stripe Stripe

Table 27. Flags page parameters – Peak Information dialog box (Sheet 2 of 4)

Parameter Description
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Flags

Saturated Displays whether any of the scans in the peak were saturated. The 
data system indicates one or more saturated scans were detected by 
displaying in the Saturated check box. 

Calculated Amount Displays the amount of sample, as calculated by the data system 
using the response ratio and the calibration curve. 

Valley Detect Displays whether valley detection was turned on in the processing 
method. The data system indicates that valley detection was 
activated if the Valley Detect check box is selected. 

QC Failed Displays whether a sample failed a QC check. 

If the calculated amount is greater than the specified percentage 
difference from the expected amount, then a sample fails the QC 
test. For example, if the tolerance level is 10% and the expected 
amount is 100%, calculated amounts less than 90% or greater 
than 110% fail. 

The data system selects the check box to indicate that the sample 
type was QC and that it failed the QC test. 

RT Ref OK Displays whether the data system found the retention time 
reference component and whether it was used correctly by the 
processing method. 

If there was a retention time reference, then the check box 
indicates whether the retention time reference peak was found. 
The data system indicates it found the peak by selecting the check 
box. The application indicates it looked for the peak but did not 
find it by leaving the box blank. 

If there is no retention time reference, then the check box is 
selected because there is no correction to be made. 

Response OK Displays whether a response factor was calculated.

The data system selects the check box to indicate that it found the 
peak and the peak’s internal standard and correctly calculated the 
response ratio. 

Table 27. Flags page parameters – Peak Information dialog box (Sheet 3 of 4)

Parameter Description
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More Flags Page – Peak Information Dialog Box 

Use the More Flags page of the Peak Information dialog box to review the following properties 
for the current component.

A red check, , means that the parameter failed to meet the specified tolerance setting.

This table describes the parameters on the More Flags page of the Peak Information dialog 
box.

Response Low Displays whether the calculated amount for the peak was less than 
the lowest specified standard amount of the component in the 
calibration curve. In this case the calculated amount has been 
determined by extrapolation from the lowest level. The data 
system selects the check box to indicate that the amount was 
calculated by extrapolation. If you force or include the origin, the 
application defines the lowest level to be 0.0. 

Response High Displays whether the calculated amount for the peak was greater 
than the highest specified standard amount of the component in 
the calibration curve. In this case, the calculated amount has been 
determined by extrapolation from the highest level. The data 
system selects the check box to indicate that the amount was 
calculated by extrapolation. 

Table 27. Flags page parameters – Peak Information dialog box (Sheet 4 of 4)

Parameter Description

Table 28. More Flags page parameters – Peak Information dialog box (Sheet 1 of 2)

Parameter Description

Detection Thresholds

When creating a processing method, set these thresholds in the Data Flags dialog box. 

Area Set a specified area tolerance value to compare with the peak area 
and determine if the peak area is outside or within the tolerance. 

Height Set a specified height tolerance value to compare with the peak 
height and determine if the peak height is outside or within the 
tolerance. 
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Chro Page – Peak Information Dialog Box 

The Chro page of the Peak Information dialog box is a read-only page that displays the single 
mass chromatogram of the current qualifier ion. The view centers on the retention time of the 
peak apex and has View Width specified in the Component Identification view of the 
Processing Setup window. The mass of the qualifier ion is displayed in the title bar Qual Ion 
Mass xxx.x. You cannot change this display.

This page is available for GC/MS data only.

Calibration and Quantitation Flag Thresholds

When creating a processing method, set these thresholds in the Calibration and 
Quantitation Flags dialog box. You can view and change these settings in the Calibration 
Settings dialog box (see “Calibration Settings Dialog Box” on page 98).

R-Squared Set a specified coefficient tolerance value to compare with the 
coefficient of determination and determine if the coefficient of 
determination is outside or within the specified tolerance.

Detection Limit Set a specified detection threshold tolerance value to compare with 
the concentration of the quantified peak and determine if the 
detection threshold is outside or within the specified tolerance. 

Linearity Limit Set a specified linearity threshold tolerance value to compare with 
the linearity threshold for the concentration of the quantified peak 
to determine if the linearity threshold is outside or within the 
specified tolerance. 

Quantitation Limit Set a specified quantitation threshold tolerance value to compare 
with the quantitation threshold for the concentration of the 
quantified peak and determine if the quantitation threshold is 
outside or within the specified tolerance. 

Carry over Limit Set a specified carry-over threshold tolerance value to compare 
with the carry-over threshold for the concentration of the 
quantified peak and determine if the carry-over threshold is 
outside or within the specified tolerance. 

Table 28. More Flags page parameters – Peak Information dialog box (Sheet 2 of 2)

Parameter Description



A Quan Browser Window
Quan Browser Dialog Boxes

116 Xcalibur Quan Browser User Guide Thermo Scientific

Info or More Info Page – Peak Information Dialog Box 

The Info or More Info page of the Peak Information dialog box is displayed if you have 
conducted a spectrum search.

• If the main component peak was detected using the spectrum search, then this page has 
the More Info tab and displays only the Spectrum box. In this case, the pages displayed 
are Info, More Info, Flags, More Flags, Suitability, and Spectrum. 

• If peaks other than the main component were detected using the spectrum search (second 
or third candidates), then this page has the Info tab and displays both the Spectrum box 
and the Peak Info box. In this case, the pages displayed are Info, Chro, and Spectrum. 

Use this page to review the following peak properties for the current search component.

This table describes the parameters on the Info and More Info pages of the Peak Information 
dialog box.

Table 29. Info or More Info page parameters – Peak Information dialog box (Sheet 1 of 2)

Parameter Description

Spectrum Results Displays the calculated Forward, Reverse, and Match results for 
the found peak (read-only).

This box appears on the More Info page for Candidate #1 of a 
spectrum search and on the Info page for Candidate #2 and 
Candidate #3 of a spectrum search. 

Forward Displays the forward threshold result for the current component 
(read-only). 

Reverse Displays the reverse threshold result for the current component 
(read-only). 

Match Displays the match threshold result for the current component 
(read-only). 

Peak Info Displays the calculated peak characteristics for Candidate #2 or 
Candidate #3 of a spectrum search (read-only). The Left, Apex, 
and Right peak boundaries in minutes, and the Area and Height 
of the peak are given in units of counts.

This box on the More Info page does not appear for Candidate #1 
of a spectrum search. This information is provided on the More 
page that appears for Candidate #1. 

Left Displays the left extreme of the integration baseline for the current 
component in minutes (read-only). 

Apex Displays the apex point in minutes of the integration baseline for 
the current component (read-only). 
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More Info Page – Peak Information Dialog Box 

Use the More Info page of the Peak Information dialog box to review the results of the 
following peak tests for the current component.

This page is available for GC/MS data only.

This table describes the parameters on the More Info page of the Peak Information dialog box.

Right Displays the right extreme of the integration baseline for the 
current component in minutes (read-only). 

Area Displays the area of the current component peak in units of 
count-seconds (read-only). 

Height Displays the height of the current component peak apex in units 
of counts (read-only). 

Table 29. Info or More Info page parameters – Peak Information dialog box (Sheet 2 of 2)

Parameter Description

Table 30. More Info page parameters – Peak Information dialog box (Sheet 1 of 2)

Parameter Description

Ion Coelution Test

Passed Displays whether the qualifier ion displayed in the title bar “Qual 
Ion Mass xxx.x” passed or did not pass the Ion Coelution test. 

If the check box is not selected, no Ion Ratio test was performed 
and the Ion Ratio Test box is not displayed. If the check box is 
selected, the Ion Ratio test was performed and the Ion Ratio Test 
box on the Mass Info page is displayed at the bottom of the Mass 
Info page.

Ion Ratio Test

Passed Displays whether the qualifier ion displayed in the title bar “Qual 
Ion Mass xxx.x” passed or did not pass the Ion Ratio test. 

The Xcalibur data system does not display this box if the current 
qualifier ion did not pass the Ion Coelution test. 
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Spectrum Page – Peak Information Dialog Box 

This read-only page displays the spectrum of the current peak at the apex retention time. You 
cannot make adjustments to this display.

Suitability Page – Peak Information Dialog Box 

The Suitability page of the of the Peak Information dialog box displays the results of specific 
tests that might have been performed (as specified by the processing method) on the 
component peak to determine its suitability to be considered a valid peak. Each test is listed 
with the result of that test displayed to the right. There are three possible responses for each 
test: Passed, Failed, and Not Tested.

This table describes the parameters on the Suitability page of the Peak Information dialog box.

Target Ratio% Displays the calculated Target Ratio Percentage that Xcalibur 
calculated during the Ion Ratio test (read-only). 

The application does not display this box if the current qualifier 
ion did not pass the Ion Coelution test. 

Absolute Window% Displays the calculated Absolute Window Percentage that 
Xcalibur calculated during the Ion Ratio test (read-only). 

The application does not display this box if the current qualifier 
ion did not pass the Ion Coelution test. 

Table 30. More Info page parameters – Peak Information dialog box (Sheet 2 of 2)

Parameter Description

Table 31. Suitability page parameters – Peak Information dialog box (Sheet 1 of 2)

Parameter Description

Suitability Flags

Symmetrical Displays the results of the Symmetrical test as Passed, Failed, or 
Not Tested. This test indicates whether the peak is symmetrical 
about the apex. 

Resolution Displays the results of the Resolution test as Passed, Failed, or Not 
Tested. This test indicates whether multiple peaks are resolved. If 
neither peak baseline endpoint is valley detected, then the 
resolution passes. 

Peak Width Displays the results of the Peak Width test as Passed, Failed, or 
Not Tested. This test indicates whether the peak width is within 
specified limits. 

Tailing Displays the results of the Tailing test as Passed, Failed, or Not 
Tested. This test indicates whether the peak has tailing. 
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Quantitation Results Sorting Order Dialog Box

Use the Quantitation Results Sorting Order dialog box to set the sort order for the samples in 
the results grid view of the Quan Browser window. The sort order defines the priority for each 
parameter used in the sort. 

For more information, see “Changing the Sort Order” on page 32.

This table describes the parameters in the Quantitation Results Sorting Order dialog box.

Column Overload Displays the results of the Column Overload test as Passed, Failed, 
or Not Tested. This test indicates whether it is likely that the 
column was overloaded during acquisition. This test is based on 
an analysis of the baseline and peak shape. 

Baseline Clipping Displays the results of the Baseline Clipping test as Passed, Failed, 
or Not Tested. This test indicates whether the baseline is clipped 
outside the peak. This can occur if the chromatogram was started 
or terminated prematurely.

Signal-to-noise Ratio Displays the results of the Signal-to-noise test as Passed, Failed, or 
Not Tested. This test indicates whether the minimum 
signal-to-noise ratio criteria are met. 

Concave Displays the results of the Concave test as Passed, Failed, or Not 
Tested. This test indicates whether the peak exhibits a concave 
depression (local minimum) due to noise. 

Saturation Displays the results of the Saturation test as Passed, Failed, or Not 
Tested. This test indicates whether the detector was saturated 
during acquisition. 

Table 31. Suitability page parameters – Peak Information dialog box (Sheet 2 of 2)

Parameter Description

Table 32. Quantitation Results Sorting Order dialog box parameters (Sheet 1 of 2)

Parameter Description

Sorting

First Order Base the first sort order of the results grid view on any of the 
following column headings or file properties: <none>, 
%Difference, %RSD, Area/Height, Area/Height Ratio, Exclude, 
File Name, Integration Type, Level Name, Peak Status, Sample 
ID, Sample Type, or Acquisition Date. By default, the first order 
sort is set to the acquisition date of the file. You can select and sort 
with any of these sort options, even if the corresponding column is 
not currently displayed. For example, you can sort by sample type, 
even if you have selected the Sample Name check box in the 
Result List Column Hiding dialog box. 
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Sort in descending 
order

Sort the first criterion in descending (reverse) order. If you do not 
select this check box, the sort is in ascending order. 

Second Order Base the second sort order of the results grid view on any of the 
following column headings or file properties: <none>, 
%Difference, %RSD, Area/Height, Area/Height Ratio, Exclude, 
File Name, Integration Type, Level Name, Peak Status, Sample 
ID, Sample Type, or Acquisition Date. You can select and sort 
with any of these sort options, even if the corresponding column is 
not currently displayed. For example, you can sort by sample type, 
even if you have selected the Sample Name check box in the 
Result List Column Hiding dialog box.

Sort in descending 
order

Sort the second criterion in descending (reverse) order. If you do 
not select this check box, the sort is in ascending order. 

Third Order Base the third sort order of the results grid view on any of the 
following column headings or file properties: <none>, 
%Difference, %RSD, Area/Height, Area/Height Ratio, Exclude, 
File Name, Integration Type, Level Name, Peak Status, Sample 
ID, Sample Type, or Acquisition Date. You can select and sort 
with any of these sort options, even if the corresponding column is 
not currently displayed. For example, you can sort by sample type, 
even if you have selected the Sample Name check box in the 
Result List Column Hiding dialog box. 

Sort in descending 
order

Sort the third criterion in descending (reverse) order. If you do not 
select this check box, the sort is in ascending order. 

Button

Save As Default Save your current selection of second and third sort orders as your 
default set. The data system uses these sort orders to display the 
results grid view until you use the Quantitation Results Setting 
Order dialog box to change your column sorting preferences. 

Table 32. Quantitation Results Sorting Order dialog box parameters (Sheet 2 of 2)

Parameter Description
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Reports Dialog Box

Use the Reports dialog box to generate reports on each sample row within the current bracket.

The Reports dialog box opens with a selection of Report templates and data files preloaded. 
These are obtained from the processing method that was previously defined and loaded along 
with the result file. This means that the values loaded might change as various brackets are 
selected.

For more information, see “Generating Reports” on page 68.

This table describes the parameters in the Reports dialog box.

Note  You can use the standard report templates provided with the Xcalibur data system or 
you can create your own custom report templates. For information on how to create a 
report template, refer to the XReport User Guide. 

Table 33. Reports dialog box parameters (Sheet 1 of 5)

Parameter Description

Sample Reports

Enabled Specifies whether the reports marked with Yes in their row are 
processed using the template that appears in the Report Template 
Name box. For example, if Yes appears in the QCs and Unknowns 
boxes and the Enable box in the row displays Yes, then the data 
system prints these sample reports. If the Enabled box in the row 
is clear, then the application does not print any sample reports.

When you click an Enabled box, a check box control appears. If 
you select this check box and you click another cell, the 
application displays the word Yes to indicate that the report is 
enabled. If you do not select the check box, the cell remains blank 
when you click another cell.
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Stds Specifies whether the Standards (Stds) sample reports marked with 
Yes are processed using the report template that appears in the 
Report Template Name box of the same row. 

To print a Standard sample report, the data system must display 
Yes in the Enabled box in the same row. For example, if the Std 
box displays Yes and the Enable box in the same row displays Yes, 
then the application prints the Std sample report. However, if the 
Enabled box in the row is clear, then the application does not 
print the Std sample report.

When you click a Stds box, a check box control appears. If you 
select this check box and you click another cell, the data system 
displays the word Yes to indicate that the report is enabled for 
Standard samples. If it is not selected, the cell remains blank when 
you click another cell.

QCs Specifies whether the Quality Controls (QCs) sample reports 
marked with Yes are processed using the report template that 
appears in the Report Template Name box of the same row. 

To print a Quality Controls sample report, the data system must 
display Yes in the Enabled box in the same row. For example, if the 
Std box displays Yes and the Enable box in the same row displays 
Yes, then the data system prints the QCs sample report. However, 
if the Enabled box in the row is clear, then the application does 
not print the QCs sample report.

When you select a QCs box, a check box control appears. If you 
select this check box and you click another cell, the data system 
displays the word Yes to indicate that the report is enabled for QC 
samples. If you do not select the check box, the cell remains blank 
when you click another cell.

Table 33. Reports dialog box parameters (Sheet 2 of 5)

Parameter Description
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Unks Specifies whether the Unknowns (Unks) sample reports marked 
with Yes are processed using the report template that appears in 
the Report Template Name box of the same row. 

To print an Unknowns sample report, the data system must 
display Yes in the Enabled box in the same row. For example, if the 
Unks box displays Yes and the Enable box in the same row displays 
Yes, then the application prints the Unks sample report. However, 
if the Enabled box in the row is clear, then the application does 
not print the Unks sample report.

When you select an Unks box, a check box control appears. If you 
select this check box and you click another cell, the data system 
displays the word Yes to indicate that the report is enabled for Unk 
samples. If you do not select the check box, the cell remains blank 
when you click another cell.

Other Specifies whether the Other sample reports marked with Yes are 
processed using the report template that appears in the Report 
Template Name box of the same row. 

To print an Other sample report, the data system must display Yes 
in the Enabled box in the same row. For example, if the Other box 
displays Yes and the Enable box in the same row displays Yes, then 
the application prints the Other sample report. However, if the 
Enabled box in the row is clear, then the application does not 
print the Other sample report.

When you select an Other box, a check box control appears. If you 
select this check box and you click another cell, the application 
displays the word Yes to indicate that the report is enabled for 
Other samples. If you do not select the check box, the cell remains 
blank when you click another cell.

Table 33. Reports dialog box parameters (Sheet 3 of 5)

Parameter Description
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Save As Specifies the file type for the sample report. These are the file type 
selections: 

• None: print only, no exported file

• Text: ASCII plain text file (TXT)

• Doc: Microsoft Word document (DOC)

• HTML: hypertext markup language file (HTML)

• PDF: portable document format file (PDF)

• RTF: rich text format file (RTF)

• XLS: Excel spreadsheet (XLS)

The data system saves the exported file with the sample file name 
and the appropriate extension in the folder where the selected 
result files are stored.

Report Template Name Specifies the report template to be used in processing the data and 
generating the reports indicated by Yes in each row. 

Double-clicking the grid cell opens the Open Report Template 
dialog box, where you select a template file. For information on 
how to create a report template, refer to the XReport User Guide.

Summary Reports

Enabled Specifies whether the summary reports are processed using the 
templates that appear in the Report Template Name boxes. For 
example, if the Enable box in the row displays Yes, then the data 
system prints the summary report defined by the report template 
in the row. If the Enabled box in the row is clear, then the 
application does not print this summary report.

When you select an Enabled box, a check box control appears. If 
you select this check box and you click another cell, the 
application displays the word Yes to indicate that the report is 
enabled. If you do not select the check box, the cell remains blank 
when you click another cell.

Table 33. Reports dialog box parameters (Sheet 4 of 5)

Parameter Description
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Save As Specifies the file type for the summary report. These are the valid 
export file types:

• None: print only, no exported file

• Text: ASCII plain text file (TXT)

• Doc: Microsoft Word document (DOC)

• HTML: hypertext markup language file (HTML)

• PDF: portable document format file (PDF)

• RTF: rich text format file (RTF)

• XLS: Excel spreadsheet (XLS)

The data system saves the exported file with the sample file name 
and the appropriate extension in the folder where the selected 
result files are stored.

Report Template Name Specifies the summary report template to be used in processing 
the summary report. 

Double-clicking the grid cell opens the Open Report Template 
dialog box, where you select a template file. For information on 
how to create a report template, refer to the XReport User Guide.

Other Controls

Include Sample Report Select whether to print sample reports when you process the 
current data. This check box controls the printing of all of the 
sample reports defined in the Sample Reports box.

Include Summary 
Report

Select whether to print summary reports when you process the 
current data. This check box controls the printing of all of the 
summary reports defined in the Summary Reports box.

Select Samples Opens the Select Report Samples dialog box, where you select the 
samples to be included in the reports. For more information, see 
“Select Report Samples Dialog Box” on page 128.

Print Reports Print the reports for the samples you have selected. 

Table 33. Reports dialog box parameters (Sheet 5 of 5)

Parameter Description
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Result List Column Hiding Dialog Box

The Result List Column Hiding dialog box contains the list of possible columns that can be 
viewed in the results grid. Selecting the check box to the left of the column name adds the 
column to the grid, and clearing the check box removes the column from the grid.

This table describes the parameters in the Result List Column Hiding dialog box.

Table 34. Result List Column dialog box parameters

Parameter Description

Selected Columns These settings indicate whether to display a column in the results 
grid. The following columns are available:

• File Name

• Sample Type

• Sample Name

• Integration Type

• Area/Height

• ISTD Area/Height

• Area/Height Ratio

• Specified Amount

• Calculated Amount

• Percent Difference

• Percent RSD

• Peak Status

• Levels

• Units

• Retention Time

• Sample ID

• Exclude
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Select Level Dialog Box

Use the Select Level dialog box to select a level for a Standard or QC sample type in the results 
grid view of the Quan Browser window.

This table describes the parameters in the Select Level dialog box.

Note  Whenever you change a QC, Blank, or Unknown sample type to a Standard sample 
type or change a Standard, Blank, or Unknown sample type to a QC sample type in the 
Quan Browser window results grid view, the Select Level dialog box opens so that you can 
select one of the available levels for the Standard or QC sample.

Table 35. Select Level dialog box parameters

Parameter Description

Levels Select one of the available levels for the Standard or QC sample 
whenever you change a QC, Blank, or Unknown sample type to a 
Standard sample type or change a Standard, Blank, or Unknown 
sample type to a QC sample type.

When you select a level from the Levels list, the read-only 
information in the lower list displays the other component names 
that are assigned to the selected level and the amount assigned to 
the selected level for each component.

Levels Table

Name View the components that are assigned the same level as the one 
currently selected in the Levels list.

Amount View the Component Amount assigned to the level currently 
selected in the Levels list for the component name selected in the 
Name column.
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Select Report Samples Dialog Box

The Select Report Samples dialog box displays the samples in the current bracket or group in 
the Sample Choices box.

From the Sample Choices dialog box, you can pick which samples are to be processed when 
sample reports are selected. Use the SHIFT and CTRL keys to select multiple samples. The 
data system remembers the selected samples for each bracket until the application is 
terminated or a new file is opened.

This table describes the parameters in the Select Report Samples dialog box.

Table 36. Select Report Samples dialog box parameters

Parameter Description

Sample Choices

Raw File View or change the raw files in the current bracket or current 
group of samples. These are the sample files that you select from 
for processing and for printing a report. 

Sample Type View the sample type of the raw file displayed to the left on the 
same row. 

Selected Samples

Raw File View or change the raw files that have been selected from the 
Sample Choices box. These are the sample files to be processed so 
that you can print a report. 

Sample Type View the sample type of the raw file displayed to the left on the 
same row. 

Buttons

Add Add files selected in the Sample Choices box to the Selected 
Samples box. 

Remove Return files selected in the Selected Choices box back to the 
Sample Choices box. 

Add All Add all of the files in the Sample Choices box to the Selected 
Samples box. 

Remove All Return all files in the Selected Choices box back to the Sample 
Choices box. 
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User Identification Settings Dialog Box

Use the User Identification Settings dialog box to select and test mass, scan filter, relative peak 
height threshold, peak identification, and peak integration settings. If these standard options 
do not provide the desired results, Quan Browser also provides advanced options using the 
Advanced page. The pages that are displayed depend on whether you are currently using the 
Genesis, the ICIS, or the Avalon peak detection algorithm.

For information about the identification, detection, integration, advanced, and flag 
parameters, see these topics:

• “Identification Page – User Identification Settings Dialog Box” on page 130

• “Detection Page – User Identification Settings” on page 134

• “Integration Page – User Identification Settings Dialog Box” on page 139

– “Genesis Integration Page Parameters” on page 139

– “ICIS Integration Page Parameters” on page 141

– “Avalon Integration Page Parameters” on page 142

• “Advanced Page – User Identification Settings Dialog Box” on page 145

– “Genesis Advanced Page Parameters” on page 145

– “ICIS Advanced Page Parameters” on page 147

• “Flags Page – User Identification Settings Dialog Box” on page 148

 To open the User Identification Settings dialog box

Right-click the chromatogram view in the Quan Browser window and choose User Peak 
Detection Settings from the shortcut menu.
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Identification Page – User Identification Settings Dialog Box 

Use the Identification page to change the current component name, mass range, scan filter, 
and retention time for the selected component. You can then test the results of the new 
settings by clicking Apply or OK. You can apply the new settings to all files in the results grid 
by clicking Apply To All.

The Identification page helps to narrow the search parameters and to set filters so that the 
peak detection algorithms have an easier time of locating the peaks. The compound of interest 
is displayed in the Name box. This is a read-only field. To select a different compound, select 
the name in the component list on the right side of the display.

This table describes the parameters on the Identification page of the User Identification 
Settings dialog box.

Table 37. Identification page parameters – User Identification Settings dialog box (Sheet 1 of 5)

Parameter Description

Name Displays the component name selected in the components pane 
for the active processing method. 

Plot Type These three lists display the type of trace and optional trace math 
operation that is stored in the processing method. Only certain 
combinations of plot types are possible as shown in the following 
table:

1st Plot Type Math Operation 2nd Plot Type 

Mass Range None n/a

Mass Range ± Mass Range

TIC n/a

TIC- Mass Range

TIC- Base Peak

Base Peak None n/a

Base Peak ± Mass Range

Analog 1, 2, 3, or 4 None n/a

Analog 1, 2, 3, or 4 ± Digital* 1, 2, 3, or 4

Digital 1, 2, 3, or 4 None n/a

Digital 1, 2, 3, or 4 ± Digital* 1, 2, 3, or 4
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Scan Filter This box displays the current scan filter for the active raw file 
(RAW). You can use a scan filter to specify that processing is to be 
applied to a subset of the scans in a raw file.

To apply a different scan filter, select a new filter from the scan 
filter list (most common method), select a new filter from the list 
and edit the scan filter, or type a new scan filter command string 
into the box using the scan filter format. 

For example, the following scan filter:

c full ms [26.81–251] 

finds all scans in a raw file that have the following properties:

centroid data

Scan Mode: Full

Scan Power: MS

Product Ion Mass Range: m/z 26.81 to 251.00

The data system displays this box when you select a Base Peak 
trace for an MS detector type. The box displays the range within 
which the application is to search for the highest peak.

If you type a single m/z value in this box, that defines the base 
peak. 

To change the base peak mass range, type the value in the box. A 
mass range from m/z=A to m/z=B is entered in the format A–B.

The data system displays this box when you select a Base Peak ± 
Mass Range trace combination for an MS detector type. The box 
displays the mass range for the second, Mass Range, trace type.

To change the range or to add a new range, type the range in the 
box. The format is Low Mass–High Mass. For example, for the 
range m/z 123 through 456, type: 123–456.

Table 37. Identification page parameters – User Identification Settings dialog box (Sheet 2 of 5)

Parameter Description
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Mass Displays the masses stored in the processing method. This display 
area changes to accommodate the type of data required. When a 
single mass range is required, there is a single edit box displaying 
the current value. If two mass ranges are required (such as the case 
of a trace defined as a Mass Range ± Mass Range or Base 
Peak ± Mass Range), this box is replaced by two boxes (in the case 
of Base Peak ± Mass Range, this box is replaced by the BP and MR 
boxes). In the case of a TIC (no trace operator in use), Analog, or 
Digital traces, this box is blank.

Keys
(read-only)

Displays user comments about the processing method. 

Retention Time

The settings in this area define the expected retention time in minutes of the component 
peak and the error window in seconds for the retention time.

Expected This box displays the expected peak width parameter (in seconds). 
This controls the minimum width that a peak is expected to have 
if valley detection is enabled. 

With valley detection enabled, any valley points nearer than the 
expected width/2 to the top of the peak are ignored. If a valley 
point is found outside the expected peak width, the data system 
terminates the peak at that point. It always terminates a peak 
when the signal reaches the baseline, independent of the value set 
for the expected peak width. The valid range is 0.0 to 999.0 
seconds. To change the current value, type a new width in the 
Expected box. 

Window This box displays the allowable retention time window for the 
elution of the selected component. The valid range is 1.0 to 999.0 
seconds. To change the time window or to enter a new time 
window, type the number of seconds in the (retention time) 
Window box. 

Use as RT Reference
(read-only)

This check box indicates whether the actual retention time (RT) 
of the active component [as displayed in the Name combo box in 
the same view] was used to adjust the expected retention time of 
another component. 

View Width This box displays the current view width (in minutes). The valid 
range is dependent upon the configured hardware. To change the 
view width, type the desired time in the View Width text box.

Table 37. Identification page parameters – User Identification Settings dialog box (Sheet 3 of 5)

Parameter Description
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Adjust Using
(read-only)

This check box indicates whether the expected retention time 
(RT) of the active component (as displayed in the Name box in 
the same view) is to be adjusted using the actual retention time of 
the RT Reference, such as an internal standard. The data system 
displays the RT Reference in the Adjust Using box to the right of 
this check box. 

Adjust Using (box)
(read-only)

This box displays the retention reference component that data 
system uses to adjust the expected retention time of the active 
component (as displayed in the Name box in the same view. The 
data system uses the actual retention time of the RT Reference 
component to correct the retention time of the active component. 
The application provides the following correction to the expected 
retention time. 

Where:

Comp RTadjusted is the adjusted expected RT of the active 
component.

Ref RTactual is the actual RT of the reference component.

Ref RTexpected is the expected RT of the reference component.

Detector Type

Type View detector type options. These are the detectors that you have 
configured using the Foundation Instrument Configuration 
dialog box. 

Peak Detection 
Algorithm

This list contains three options from which you can select a peak 
detection algorithm to recalculate the data using that algorithm. 

Table 37. Identification page parameters – User Identification Settings dialog box (Sheet 4 of 5)

Parameter Description

Comp RTadjusted
Comp RTexpected Ref RTactual

Ref RTexpected
-----------------------------------------------------------------------------------------=
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Detection Page – User Identification Settings 

Use the Detection page from the User Identification Settings dialog box to change the current 
peak detection criteria for component detection. The parameters on the Detection page vary 
depending on whether you use a GC or LC, whether the detection method is Spectrum, 
Highest Peak, or Nearest RT, and the selected integration algorithm.

This table describes the parameters on the User Identification Settings – Detection page. 

Buttons

Apply Applies the current peak detection parameters to the selected 
component of the selected sample in the current sequence. 

Apply to All Applies the current peak detection parameters to all samples that 
are currently displayed in the sequence. For example, if 
“Standards” are displayed, the current peak detection parameters 
are applied to only the Standards samples and not to any other 
samples. If “All” samples are displayed, the current peak detection 
parameters are applied to all samples in the current sequence. 

If one or more Standard samples are changed, the data system 
recalculates all quantitation parameters, including peak areas and 
the calibration curve.

If one or more Standard samples are changed, the data system 
recalculates all quantitation parameters, including peak areas and 
the calibration curve.

Table 37. Identification page parameters – User Identification Settings dialog box (Sheet 5 of 5)

Parameter Description

Table 38. Detection page parameters – User Identification Settings dialog box (Sheet 1 of 5)

Parameter Description

Highest Peak This option is available for both LC/MS and GC/MS data. Use the highest peak in the 
chromatogram for component identification. 

Nearest RT This option is available for both LC/MS and GC/MS data. Use the peak with the nearest 
retention time in the chromatogram for component identification. 

Minimum Peak Height This parameter is available for the ICIS and Genesis algorithms. View or change the peak 
signal-to-noise criteria that needs to be equaled or exceeded for the data system to use the 
Nearest RT Peak Identification criteria. When identifying components, the application 
ignores all chromatogram peaks that have signal-to-noise values that are less than the S/N 
Threshold value. The valid range is 0.0 (all peaks) through 999.0. 
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Spectrum This option is only available for GC/MS data. You can use a reference spectrum defined in 
the processing method for component identification. The data system attempts to match 
the reference spectrum with a series of unknown spectra and calculates a score value for each 
comparison.

If you select the Spectrum option for GC/MS data, the following parameters appear: 

• Spectrum Peak Detection: Displayed only for GC/MS data when you select the 
Spectrum option. You must also have selected the MS detector type on the 
Identification page.

• Spectrum Peak Identification table: Enter mass/charge [m/z] and intensity data for up to 
50 spectrum peaks. The data system uses this data to identify the active component in 
the Find algorithm. It displays this table only when you select the Spectrum option for 
GC/MS data. 

• m/z: View the mass/charge [m/z] value for one peak in the reference spectrum. The 
intensity for this m/z value is given in the adjacent Intensity table box. Use the other 
rows of the table to enter as many as 50 m/z values. The data system uses this data to 
identify the active component in the Find algorithm. It displays this table only when 
you select the Spectrum option for GC/MS data.

• Intensity: Enter intensity data for one peak in the reference spectrum. The m/z value for 
this intensity is given in the adjacent m/z Table box. Use the other rows of the table to 
enter as many as 50 intensity values. The data system uses this data to identify the active 
component in the Find algorithm. It displays this table only when you select the 
Spectrum option for GC/MS data. 

Thresholds (for the Spectrum option)

Forward Set a threshold value for Forward comparisons between the reference spectrum and 
candidates in the chromatogram. A Forward search is a direct matching algorithm 
comparing unknowns against the reference spectrum in the peak identification table. The 
match is scored on a scale of 0 to 999. A perfect match results in a score of 999. As a general 
guide, 900 or greater is an excellent match; 800 to 900 a good match; 700 to 800 a fair 
match. Less than 600 is a poor match. Unknown spectra with many peaks tend to score 
lower than similar spectra with fewer peaks. 

Reverse Set a threshold value for Reverse comparisons between the reference spectrum and 
candidates in the chromatogram. A Reverse search ignores any peaks in the unknown that 
are not in the reference spectrum in the peak identification table. The match is scored on a 
scale of 0 to 999. A perfect match results in a score of 999. As a general guide, 900 or greater 
is an excellent match; 800 to 900 a good match; 700 to 800 a fair match. Less than 600 is a 
poor match. A spectrum with many peaks tends to score more highly in a Reverse match 
than a Forward match.

Table 38. Detection page parameters – User Identification Settings dialog box (Sheet 2 of 5)

Parameter Description
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Match Set a threshold value for Match comparisons between the reference spectrum and candidates 
in the chromatogram. Match is scored on a scale of 0 to 999. The Match algorithm is a 
complex probability factor based on the differences between the Forward factors of all the 
candidates. If one candidate has a Forward matching factor of 900 and the next best is only 
300, the probability of the component being correctly identified is high and so the Match 
factor is scored highly for the first candidate. If the Forward factors for all the candidates are 
similar, whether high or low, the Match factor is low. 

Ion Ratio Confirmation (GC/MS data)

If you are working with GC/MS data and you select the Highest Peak or Nearest RT options, the Ion Ratio 
Confirmation area appears. You must also have selected the MS detector type on the Identification page.

Enable Indicates whether Ion Ratio Confirmation is enabled.

Ion Ratio Using: Area 
or Height 

View the currently selected peak quantitation method: area or height. The data system uses 
the same method to calculate qualifier ion peak response and then target ratio. You can 
change this parameter by selecting the Area or Height options in the Response box on the 
Calibration page. 

Qualifier Ion Table Specify up to five qualifier ions in this box to confirm the detection of a target analyte. You 
can also set the coelution window and select a method for calculating the target ion ratio 
window and tolerance. 

Use this table to enter mass/charge [m/z] and target ratio tolerances [Window (±%)] data for 
up to five qualifier ions. 

• If you are using Area response, the data system integrates each qualifier ion peak and 
ratios it with the quantitation peak area. The application then compares this ratio with 
your specified target ratio. If the calculated ratio is outside of the target ratio by more 
than your specified tolerance [Window (±%)], the quantitation peak is rejected.

• If you are using Height response, the data system ratios the qualifier ion peak height 
with that of quantitation peak. The application then compares this ratio with your 
specified target ratio. If the calculated ratio is outside of the target ratio by more than 
your specified tolerance [Window (±%)], the quantitation peak is rejected.

m/z column This column in the Qualifier Ion table displays the mass/charge [m/z] value for a qualifier 
ion. The target ratio tolerance for this m/z value is displayed in the adjacent Window(±%) 
table box. Use other rows of the table to enter data for five qualifier ions. The data system 
uses this data to confirm the identity of a quantitation peak by comparing the relative 
responses of qualifier ion and quantitation peaks with predetermined values.

Table 38. Detection page parameters – User Identification Settings dialog box (Sheet 3 of 5)

Parameter Description
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Target Ratio This column in the Qualifier Ion table displays the Target Ratio (%) value for a qualifier 
ion. The m/z value and target ratio tolerance for the qualifier ion are given in the adjacent 
m/z and [Window (±%)] table boxes. Use other rows of the table to enter data for five 
qualifier ions. The data system uses this data to confirm the identity of a quantitation peak 
by comparing the relative responses of qualifier ion and quantitation peaks with 
predetermined values.

Window Use this column in the Qualifier Ion table to specify the Target Ratio tolerance for a 
qualifier ion. Use other rows of the table to enter data for five qualifier ions. The data system 
uses this data to confirm the identity of a quantitation peak by comparing the relative 
responses of qualifier ion and quantitation peaks with the specified values.

Window (%) Select Relative or Absolute.

• Relative

Specify that the target ratio tolerance values in the Window (±%) column of the 
qualifier ion table are relative values. 

For example, if the target ratio is 50% and the Window (±%) parameter is 20%, the 
expected target ion ratio range is 40% to 60% (with the Absolute option this would be 
30% to 70%). If the ion ratio is outside this range, the ion ratio confirmation test has 
failed and the data system sets the IRC Flag to false. If the qualifier ion 
peak/quantitation peak ratio is within range, the ion ratio confirmation test passes and 
the application sets the IRC Flag to true. The response of all specified qualifier ions 
must be within the respective ratio ranges for IRC to succeed.

In assessing a target ion ratio range, the application truncates the range at 0% to avoid 
negative values.

• Absolute

Specify that the target ratio tolerance values in the Window (±%) column of the 
qualifier ion table are absolute values. 

For example, if the target ratio is 50% and the Window (±%) parameter is 20%, the 
expected target ion ratio range is 30% to 70% (with the Relative option this would be 
40% to 60%). If the qualifier ion peak/quantitation peak ratio is outside this range, the 
ion ratio confirmation test has failed and the data system sets the IRC Flag to false. If 
the qualifier ion peak/quantitation peak ratio is within range, the ion ratio confirmation 
test passes and the application sets the IRC Flag to true. The response of all specified 
qualifier ions must be within the respective ratio ranges for IRC to succeed.

In assessing a target ion ratio range, the data system truncates the range at 0% to avoid 
negative values.

Table 38. Detection page parameters – User Identification Settings dialog box (Sheet 4 of 5)

Parameter Description
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Qualifier Coelution Qualifier Ion Coelution window.

• Prior to ion ratio confirmation, the data system generates a mass chromatogram for 
each specified qualifier ion. Each of these chromatograms must feature a peak, 
matching that of the quantitation masses. If the retention time of the qualifier ion peak 
apex lies outside of the Qualifier Ion Coelution window (centered on the quantitation 
peak), the application rejects the quantitation peak.

• Quantitation peaks with matching qualifier ion peaks (within the Coelution window) 
are tested by Xcalibur for ion ratio confirmation.

Buttons

Apply Apply the current peak detection parameters to the selected component of the selected 
sample in the current sequence. 

If one or more standard samples are changed, the data system recalculates all quantitation 
parameters, including peak areas and the calibration curve.

Apply To All Apply the current peak detection parameters to all samples that are currently displayed in 
the sequence. For example, if you select the Standards option, the data system applies the 
current peak detection parameters only to the standards samples and not to any other 
samples. If you select the All samples option, the application applies the current peak 
detection parameters to all samples in the current sequence. 

If one or more standard samples are changed, the data system recalculates all quantitation 
parameters, including peak areas and the calibration curve.

Table 38. Detection page parameters – User Identification Settings dialog box (Sheet 5 of 5)

Parameter Description
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Integration Page – User Identification Settings Dialog Box 

Use the Integration page to change the current peak integration criteria for the selected 
component. You can then test the results of the new criteria by clicking Apply or OK. You can 
apply the new criteria to all files in the Result list by clicking Apply To All. These settings are 
used by the Detection algorithm.

Depending on the peak detection algorithm that you are using, one of three Integration pages 
is available. For information about the parameters on these pages, see these topics:

• Genesis Integration Page Parameters

• ICIS Integration Page Parameters

• Avalon Integration Page Parameters

Genesis Integration Page Parameters

This table describes the parameters on the Genesis Integration page of the User Identification 
Settings dialog box.

Table 39. Genesis Integration page parameters (Sheet 1 of 2)

Parameter Description

Smoothing Points Determine the degree of data smoothing to be performed on the 
active component peak prior to peak detection and integration. 
The valid range is any odd value between 1 (no smoothing) 
through 15 (maximum smoothing). To smooth your component 
peak data prior to integration, type a value in the Smoothing 
Points box. See also Avalon Integration Page Parameters and ICIS 
Integration Page Parameters. 

S/N Threshold View or change the current signal-to-noise threshold for peak 
integration. Peaks with signal-to-noise less than this value are not 
integrated. Peaks with signal-to-noise greater than this value are 
integrated. The valid range is 0.0 to 999.0. To change the current 
value, type a new value in the S/N Threshold box. 

Valley Detection 
Enabled

Use the Xcalibur valley detection approximation method to detect 
unresolved peaks. This method drops a vertical line from the apex 
of the valley between unresolved peaks to the baseline. The 
intersection of the vertical line and the baseline defines the end of 
the first peak and the beginning of the second peak. To turn this 
method on, select the Valley Detection check box. To turn this 
method off, ensure that the check box is clear. 
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Expected Width (sec) View the expected peak width parameter (in seconds). This 
controls the minimum width that a peak is expected to have if 
valley detection is enabled. 

With valley detection enabled, any valley points nearer than the 
expected width/2 to the top of the peak are ignored. If a valley 
point is found outside the expected peak width, the data system 
terminates the peak at that point. The application always 
terminates a peak when the signal reaches the baseline, 
independent of the value set for the expected peak width. The 
valid range is 0.0 to 999.0 seconds. To change the current value, 
type a new width in the Expected Width box. 

Constrain Peak Width Limit the peak width of a component during peak integration of a 
chromatogram. You can then set values that control when peak 
integration is turned on and off by specifying a peak height 
threshold and a tailing factor. To constrain a peak width, select the 
Constrain Peak Width check box. The Peak Ht (%) box and the 
Tailing Factor box become available. 

Peak Ht (%) View or adjust the percent of the total peak height (100%) that a 
signal needs to be above the baseline before integration is turned 
on or off. This box is active only when the Constrain Peak Width 
check box is selected. The valid range is 0.0 to 100.0%. To enter 
this height, type the appropriate value in the Peak Ht (%)box.

Tailing Factor View or adjust a factor that controls how the Xcalibur data system 
integrates the tail of a peak. This tailing factor is the maximum 
ratio of the trailing edge to the leading side of a constrained peak. 
This box is active only when the Constrain Peak Width box is 
selected. The valid range is 0.5 through 9.0. 

Table 39. Genesis Integration page parameters (Sheet 2 of 2)

Parameter Description
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ICIS Integration Page Parameters

This table describes the ICIS Integration page parameters.

Table 40. ICIS Integration page parameters – User Identification Settings dialog box

Parameter Description

Smoothing Points Type the number of points used in the moving average used to 
smooth the data. The valid range is any odd value from 1 through 
15 points. The default value is 1 point. This value is used by the 
ICIS peak detection algorithm. 

Baseline Window Specify the number of scans over which to look for a local 
minima. The valid range is 1 through 500. The default value is 40 
scans. This value is used by the ICIS peak detection algorithm. 

Area Noise Factor Specify the noise level multiplier used to determine the peak edge 
after the location of the possible peak. The valid multiplier range 
is 1 through 500. The default multiplier is 5. This value is used by 
the ICIS peak detection algorithm. 

Peak Noise Factor Specify the noise level multiplier used to determine the potential 
peak signal threshold. The valid multiplier range is 1 through 
1000. The default multiplier is 10. This value is used by the ICIS 
peak detection algorithm. 

Constrain Peak Width Limit the peak width of a component during peak integration of a 
chromatogram. You can then set values that control when peak 
integration is turned on and off by specifying a peak height 
threshold and a tailing factor. To constrain a peak width, select the 
Constrain Peak Width check box. The Peak Ht (%) box and the 
Tailing Factor box become available. 

Peak Ht (%) View or adjust the percent of the total peak height (100%) that a 
signal needs to be above the baseline before integration is turned 
on or off. This box is active only when the Constrain Peak Width 
check box is selected. The valid range is 0.0 to 100.0%. To enter 
this height, type the appropriate value in the Peak Ht (%) box.

Tailing Factor View or adjust a factor that controls how the Xcalibur data system 
integrates the tail of a peak. This tailing factor is the maximum 
ratio of the trailing edge to the leading side of a constrained peak. 
This box is active only when the Constrain Peak Width check box 
is selected. The valid range is 0.5 through 9.0. 
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Avalon Integration Page Parameters

This table describes the parameters on the Avalon Integration page of the User Identification 
Settings dialog box.

Table 41. Avalon Integration page parameters  (Sheet 1 of 3)

Parameter Description

Auto Calc Initial 
Events

This button is active with the event list of the Avalon peak 
detection algorithm only if a raw file is open. When you click the 
button, Avalon automatically estimates the initial values for the 
detection of peaks based on the data in the current raw file, and 
then displays those initial values in the event list. Use this button 
to force Avalon to search for the best values of initial events that 
detect peaks in the data. Any timed event in the event list is 
unchanged when you click this button.

Auto Calculate Initial Events determines initial values for the 
following events only: Start Threshold, End Threshold, Area 
Threshold, P-P [Resolution] Threshold, Bunch Factor, Negative 
Peaks, and Tension. Additionally, the user can specify timed events 
for these events in the same event list.

Smoothing Points View or adjust the number of points that the Xcalibur data system 
uses for chromatogram smoothing. The valid range for smoothing 
points is from 3 to 15. The number of smoothing points must be 
odd. To change the number of smoothing points, type the new 
number of points in the Smoothing Points box. 

Event List

Event List To detect peaks, Avalon uses the settings for initial events and 
user-defined timed events in the event list. To calculate values for 
initial events, click Auto Calc Initial Events. 

The event list in the Avalon Event List dialog box contains two 
hidden columns of information that are used by the algorithm and 
cannot be changed by the user: Event OP Code and Value2. 

There are seven initial entry integration events, which are 
identified by the initial value setting in the Time column. These 
are the default integration events required by the Avalon 
integration algorithm. You can change the Value of an initial entry 
integration event, but you cannot delete it or change its time 
value.

Time This column contains either the term initial value or a value of 
time in minutes. 
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Event View descriptions of detection parameters for initial events and 
timed events. 

You cannot change an event associated with an initial value.

Value View the values associated with initial events or timed events. The 
range of factors allowed for each value is specific to each event.

Event List entry

Time View or change the currently highlighted entry from the Time 
column in the event list. 

Event View the currently highlighted entry in the Event column of the 
event list. 

An event cannot be changed that is listed with an Initial Value in 
the Time column. The Threshold and Bunch Factor parameters 
are the most important ones in controlling peak detection.

Start/End Threshold Directly related to the RMS noise in the chromatogram, this is 
Threshold, the fundamental control used for peak detection.

Bunch Factor The Bunch Factor is the number of points grouped together 
during peak detection. It controls the bunching of 
chromatographic points during integration and does not affect the 
final area calculation of the peak. The Bunch Factor must be an 
integer between 1 and 6; a high bunch factor groups peaks into 
clusters.

Area Threshold Controls the area cutoff. Any peaks with a final area less than the 
area threshold is not detected. This control is in units of area for 
the data. 

P-P Threshold The peak-to-peak resolution threshold controls how much peak 
overlap must be present before two or more adjacent peaks create a 
peak cluster. Peak clusters have a baseline drop instead of 
valley-to-valley baselines. This is specified as a percent of peak 
height overlap. 

Negative Peaks Automatically resets after a negative peak has been found.

Tension Controls how closely the baseline should follow the overall shape 
of the chromatogram. A lower tension traces the baseline to follow 
changes in the chromatogram more closely. A high baseline 
tension follows the baseline less closely, over longer time intervals. 
Set in minutes.

Table 41. Avalon Integration page parameters  (Sheet 2 of 3)

Parameter Description
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Tangent Skim Using this event, you can tangent skim any peak clusters. By 
default, it chooses the tallest peak in a cluster as the parent 
(solvent). You can also identify which peak in the cluster is the 
parent. Tangent skim peaks are detected on either side (or both 
sides) of the parent peak. Tangent skim automatically resets at the 
end of the peak cluster.

Shoulders On  Turns on the detection of shoulders. 

Shoulders Off Shoulders Off Turns off the detection of shoulders. 

Force Cluster On Turns on the grouping of peaks into a single peak. 

Force Cluster Off Turns off the grouping of peaks into a single peak.

Disable Cluster On Enables the grouping effect in the specified time range. 

Disable Cluster Off Disables the grouping effect in the specified time range.

Value View or change the currently highlighted entry from the Value 
column in the event list. The range of factors allowed for each 
value is specific to each event. 

Page Buttons

Add Add to add a time/event/value entry for a timed event in the event 
list. When you click Add, both the event list and the 
chromatogram display update automatically with the added 
specification in the currently selected chromatogram. 

Delete Delete to remove a highlighted event from the event list. You 
cannot delete initial values.

Change Change to update a highlighted time/event/value entry in the 
event list. When you click Change, both the event list and the 
chromatogram display update automatically with the revised 
specification in the currently selected chromatogram. For initial 
events, only the values (and not the events) can be changed. 

Table 41. Avalon Integration page parameters  (Sheet 3 of 3)

Parameter Description
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Advanced Page – User Identification Settings Dialog Box

Use the Advanced page of the User Identification Settings dialog box to change the current 
advanced component detection criteria. Use these additional criteria if the standard detection 
criteria do not provide the desired results. You can then test the results of the new criteria by 
clicking Apply or OK. You can apply the new criteria to all files in the Result list by clicking 
Apply To All.

Advanced parameters used for the detection and integration of peaks are less often used but 
can provide adequate peak detection with the default parameters.

You can set advanced parameters for the Genesis and ICIS algorithms. For more information, 
see these topics:

• Genesis Advanced Page Parameters

• ICIS Advanced Page Parameters

Genesis Advanced Page Parameters

This table describes the parameters on the Genesis Advanced page of the User Identification 
Settings dialog box.

Table 42. Genesis Advanced page parameters  (Sheet 1 of 2)

Parameter Description

Report Noise As

RMS Select this option to calculate noise as RMS. 

Peak To Peak Select this option to calculate noise as peak-to-peak.

Manual Noise Region Specify the region of the chromatogram that the Xcalibur data 
system uses to determine noise. 

You can click the Manual Noise Region icon, , and drag the 
cursor horizontally across the region of the chromatogram that 
you want to select as the noise region or type the retention time 
(RT) in the RT Range box. The data system marks the region with 
a red baseline. 

RT Range Specify the retention time (RT) range. The RT range should be 
within the chromatogram range.

You can click the Manual Noise Region icon, , and drag the 
cursor horizontally across the region of the chromatogram that 
you want to select as the noise region or type a value in the RT 
Range box. The data system marks the region with a red baseline. 
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Rise Percentage View or adjust the percentage that the peak trace can rise above 
the baseline after passing through a minimum (before or after the 
peak). If the trace exceeds this value, the data system applies valley 
detection peak integration criteria. This test is applied to both the 
left and right edge of the peak. This criteria is useful for 
integrating peaks with long tails. The valid range is 0.1 to 500.0. 
To change the rise percentage, type a value in the Rise Percentage 
box. Click OK to apply the new peak detection criteria. 

Valley S/N View or adjust the signal-to-noise criteria that the data system uses 
for valley detection. The valid range is 1.0 to 100.0. To change the 
valley detection signal-to-noise criteria, type a value in the Valley 
S/N box. Click OK to apply the new peak detection criteria.

Peaks S/N Cutoff View or adjust the signal-to-noise below which the data system 
defines the peak edge. For example, if the signal-to-noise at the 
apex is 500 and the Peak S/N Cutoff value is 200, the application 
defines the right and left edges of the peak when the S/N reaches a 
value less than 200. The valid range is 50.0 to 10 000.0. 

Baseline Noise 
Tolerance (%)

View or adjust a value that controls how the baseline is drawn in 
the noise data. The higher the baseline noise tolerance value, the 
higher the baseline is drawn through the noise data. The valid 
range is 0.0 to 100.0. 

Min Number Of Scans 
In Baseline

View or adjust the minimum number of scans that the Xcalibur 
data system uses to calculate a baseline. A larger number includes 
more data in determining an averaged baseline. The valid range is 
2 to 100.0.

Number Of 
Background Scans

View or adjust the number of background scans used to determine 
the background. The valid range is 1 to 100.

Table 42. Genesis Advanced page parameters  (Sheet 2 of 2)

Parameter Description
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ICIS Advanced Page Parameters

This table describes the parameters on the ICIS Advanced page of the User Identification 
Settings dialog box.

Table 43. ICIS Advanced page parameters (Sheet 1 of 2)

Parameter Description

Manual Noise 
Region

Specify the region of the chromatogram that the Xcalibur data 
system uses to determine noise. 

When you select this check box, the RT Range box becomes 
available.

You can click the Manual Noise Region icon, , and drag the 
cursor horizontally across the region of the chromatogram that 
you want to select as the noise region or type the retention time 
(RT) in the RT Range box. The data system marks the region with 
a red baseline. 

RT Range Specify the retention time (RT) range. The RT range should be 
within the chromatogram range.

You can click the Manual Noise Region icon, , and drag the 
cursor horizontally across the region of the chromatogram that 
you want to select as the noise region or type a value in the RT 
Range box. The data system marks the region with a red baseline. 

Noise Method

INCOS Noise Use a single pass algorithm to determine the noise level. This value 
is used by the ICIS peak detection algorithm. 

Repetitive Noise Use a multiple pass algorithm to determine the noise level. This 
value is used by the ICIS peak detection algorithm. In general, this 
algorithm is more accurate in analyzing the noise than the INCOS 
noise algorithm, but it takes longer. 

RMS Specify that the data system calculates noise as RMS. By default, 
the data system uses peak-to-peak for the noise calculation. RMS 
is automatically selected if you determine the noise region 
manually.

Min Peak Width Type the minimum number of scans required in a peak. The valid 
range is 0 to 100 scans. The default value is 3 scans. This value is 
used by the ICIS peak detection algorithm. 

Multiplet 
Resolution

Type the minimum separation in scans between the apexes of two 
potential peaks. This is a criteria to determine if two peaks are 
resolved. The valid range is 1 to 500 scans. The default value is 10 
scans. This value is used by the ICIS peak detection algorithm. 
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Flags Page – User Identification Settings Dialog Box 

The Flags page of the User Identification Settings dialog box shows the current detection 
flagging thresholds in use for the selected compound. These values are used in determining if 
the peak detection is within user-specified limits. They do not alter the way calculations are 
made. An entered value of 0.0 forces the flag to be false.

This table describes the parameters on the Flags page of the User Identification Settings dialog 
box.

Area Tail 
Extension

Type the number of scans past the peak endpoint to use in 
averaging the intensity. The valid range is 0 to 100 scans. The 
default value is 5 scans. This value is used by the ICIS peak 
detection algorithm. 

Area Scan 
Window

Type the number of allowable scans on each side of the peak apex. 
The valid range is 0 to 100 scans. The default value of 0 scans 
specifies that all scans from peak start to peak end are to be 
included in the area integration. This value is used by the ICIS 
peak detection algorithm. 

Table 43. ICIS Advanced page parameters (Sheet 2 of 2)

Parameter Description

Table 44. Flags page parameters – User Identification Settings dialog box

Parameter Description

Area Threshold View or set a value for the current Area Threshold (AT) flag. The 
data system sets the AT flag in the result file if the quantified peak 
has an area that is lower than the entered value. 

Height Threshold View or set a value for the current Height Threshold (HT) flag. 
The data system sets the HT flag in the result file if the quantified 
peak has a height that is lower than the entered value. 
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View Sample Types Dialog Box

When opening Quan Browser, the Xcalibur data system first checks to confirm that the file 
you select is valid. After verifying that all the files exist and can be opened, but before 
displaying any data, the View Sample Types dialog box opens to prompt you to display only 
“Standards and QC samples” or “All samples.” 

The Don’t Ask Again check box is provided so that you do not have to see the dialog box again 
after making your initial selection. 

• If you select the Don’t Ask Again check box, choose Options > Enable Warnings from 
the Quan Browser menu bar to reset the display of this dialog box and all other message 
type dialog boxes.

• If you do not select the Don’t Ask Again check box, the Enable Warnings menu command 
is not available.

This table describes the parameters in the View Sample Types dialog box.

Table 45. View Sample Types dialog box parameters

Parameter Description

Viewing Options 

Show Standards and QCs Display only Standards and QCs in the Quan Browser results 
grid view. The data system does not display blanks and 
Unknowns. Select one of these tabs: Standards or QCs. 

Show All Sample Types Display Standards, QCs, Blanks, and Unknowns in the Quan 
Browser grid view. You can select from the following tabs: All, 
Standards, QCs, Blanks, or Unknowns. 

Don't Ask Again Decide whether you want to see the current message box or 
dialog box in the future. 

For example, if you always select the Show All Sample Types 
option and never select the Show Standards or QCs option, 
you might want to turn off the View Sample Types dialog 
box.

When you select the Don’t Ask Again check box, the Quan 
Browser application does not display the View Samples dialog 
box each time you open a new sequence. However, after you 
close the Quan Browser application, the data system 
automatically clears the Don’t Ask Again check box, and the 
next time you open the Quan Browser application, the View 
Sample Types box opens.

To turn on the display of all message boxes and dialog boxes, 
choose Options > Enable Warnings.
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